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1 Overview 
PGRemote application software is one component of a joint MIPI test solution offered by 
The Moving Pixel Company (TMPC) and Tektronix.  In this solution, TMPC software 
and hardware are used to provide stimulus data traffic to a target MIPI device while a 
Tektronix logic analyzer is used to capture, decode, and display bus activity using a 
custom bus support. 
 
This document describes the PGRemote software and operation of the TMPC MIPI 
solution, which makes use of the following components: 
 

1) PGRemote application: Windows application that embodies knowledge of the 
MIPI protocol suite including DCI, CSI, DSC, DCS and D-PHY to build 
signaling and command data for a general-purpose pattern generator (PG) to play 
out on the DPhy bus.1 

 
2) PGAppDotNet software: Windows control application for the PG3A pattern-

generator module with the capability to receive commands remotely via .NET.  
This software defines data blocks and playback sequences for general-purpose 
data output and, once defined, downloads this information to the PG3A hardware 
over a USB link, and manages real-time playback.  

 
3) PG3A pattern-generator module: stand-alone or TLA plug-in hardware for data 

output.  The PG3A module is a broadly generic and flexible instrument for 
generating arbitrary data patterns, using separate probe accessories to support a 
variety of digital standards and protocols. 

 
4) P331 probe: this is TMPC’s basic probe designed expressly for MIPI/DPhy 

signaling.2  The P331 probe has the following features: 
 

• Supports up to 4 data lanes plus a clock lane, each up to 1Gbps.   
• Uses two PG3A probe connections (port A and B) 
• SMA outputs for each lane 
• Proper LP-to-HS protocol on clock lane 
• Clock lane can run continuously, even when PG3A is stopped 
• Provides an optional external clock input (Opt. Clock In) port suitable for 

impaired clock testing (e.g. jitter, noise, etc), where output data is clocked 
using a filtered version of the impaired clock. 

• Proper BTA response handshaking when DUT returns control back to PG 
• LP contention detection 

                                                 
1 A newer variation of PGRemote called PGRemoteForP338 is now available that supports the P338 probe.  
Except where explicitly noted, references to PGRemote include PGRemoteP338 as well. 
2 The next-generation probe to the P331 is the P332, which supports up to 1.5 Gbps per lane.  Except where 
explicitly noted, references to the P331 include the P332 and P338 probe types as well. 
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• Ability to insert simple commands into vertical blanking while in 
continuous video mode 

• Adjustable HS voltages and delays for each lane (which have a common 
LP voltage) with support for real-time adjustment during setup 
 

5) Inputs probe: a probe used to provide an external clock input (and events) to the 
PG3A module.  When a P331 is used, the Inputs probe is necessary to connect a 
master clock from the P331 to the PG3A and the PG3A always operates in 
“External” clocking mode.3   

 
Figures 1 shows the overall test architecture when using the P331 probe.   
 

 
 

Figure 1 – MIPI Test Architecture (P331) 
 

                                                 
3  While the PG3A always operates in External clocking mode when using the P331 probe, the 
probe itself can operate in Internal or External clocking mode.  So no functionality is lost.  
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2 Setup & Installation 
This document assumes general familiarity with the PG and PGApp.  If necessary, please 
read the PGUsersManual for more information before continuing. 

2.1 Installing PGAppDotNet 
A special version of PGApp software is needed for MIPI testing, named PGAppDotNet.  
It has been modified to support a more easily used (by TMPC) remote communication 
protocol via .NET rather than the PPI interface provided via COM/DCOM.  Otherwise, 
PGAppDotNet behaves similarly to PGApp for general use (though system files between 
the two are not compatible).  It is no problem to have both PGApp and PGAppDotNet 
installed on the same machine at the same time. 
 
Installation of PGAppDotNet is straightforward.  Follow the instructions below:  
 

1) If you already have a previous version of PGAppDotNet installed, it must first be 
uninstalled.  You may do this via Windows: Start->Settings->Control Panel->Add 
or Remove Programs, scroll to PGAppDotNet and click, then click the 
Change/Remove button and follow the instructions. 

2) Run the new setup file, SetupDNXXX.exe where XXX is the application build 
number (currently 019).  If you do not have an installation disk or a setup file for 
PGApp, you may download the most recent version from www.movingpixel.com.  
Follow the installation instructions which by default will install the application in 
the folder: c:\Program Files\TMPC\PGAppDotNet.  

3) If you are planning to run on a real PG module (as opposed to just demonstrating 
in offline mode), you must obtain a TMPCLicense.txt file from the Moving Pixel 
Company and copy this file into the PGAppDotNet application directory (i.e. 
c:\Program Files\TMPC\PGAppDotNet\PGAppDotNet).  See additional 
comments at the end of this section. 

4) Run PGAppDotNet and check that you have the correct executable: use the menu 
option "Help->About PGApp" to show the version and additionally display "(Dot 
Net Server Version)". 

 
IMPORTANT: Depending on your hardware configuration and the DPhy protocols you 
wish to support, one or more license options must be enabled for your PG3A module for 
proper operation.  Options are enabled with license strings provided by TMPC and are 
derived from the module serial number and located in the file TMPCLicense.txt.  You 
will need to obtain this license file from TMPC before using the system with real 
hardware.    
 
If you are using the P331 probe, you only need the protocol option(s) enabled (i.e. DSI or 
CSI); no DDROutput option is required.  
 
To verify that licensing options are properly enabled on your module once you’ve 
installed the PGAppDotNet application, power on the PG3A, connect to PG module, and 
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use the menu "System->System Properties" to bring up the properties window and see the 
options listed. 
 
Note that if PGAppDotNet is running in Offline mode (i.e. is not connected to a physical 
PG module), all MIPI protocol options are automatically enabled for PGRemote 
demonstration. 

2.2 Installing PGRemote 
The PGRemote software is generally installed on the same computer as PGAppDotNet 
(but it is not required as long as both computers are connected via a LAN).  To install 
PGRemote, simply execute the PGRemote setup file and step through the setup windows.  
The PGRemote application is installed by default in the c:\Program 
Files\TMPC\PGRemote directory. 
 
One requirement for running the PGRemote application is the Microsoft .NET 
Framework 3.5 platform.  You can check if .NET 3.5 is installed through Start-
>Settings->Control Panel and double-clicking "Add or Remove Programs".  Scroll 
through the list of applications for "Microsoft .NET Framework 3.5".  If version 3.5 is 
present, so will versions 3.0, 2.0 and 1.1.   
 
If you are installing from an installation CD provided by The Moving Pixel Company, 
Microsoft .NET 3.5 will be installed automatically (if necessary).  On the other hand, if 
you are running the PGRemote installation from a setup file downloaded from our 
website or received via email, the setup files for installing .NET 3.5 will not be present. 
 
In this case, running the PGRemote setup on a machine without .NET 3.5 installed will 
appear to begin .NET installation (asking the user to accept supplemental license terms), 
but then will subsequently report an error installing system components.  If this occurs, 
the user should close the error report and manually install .NET 3.5.   
 
To install Microsoft .NET 3.5 (without an installation CD from The Moving Pixel 
Company) your computer must be connected to the internet.  The following is a link to 
the installation executable (note: this file is over 200 MB): 
 
http://download.microsoft.com/download/6/0/f/60fc5854-3cb8-4892-b6db-
bd4f42510f28/dotnetfx35.exe 
 
Download the executable and run it and follow the setup instructions. 
 
Finally, it has been discovered that .NET 3.5 installation may fail on some machines 
when the Windows IIS service is installed.  It appears that some TLAs have this service 
installed by default even though it is not necessary for normal operation (the Windows 
IIS service is in support of making your computer a web server).  Thus, if you cannot 
successfully install .NET 3.5, it may be necessary to uninstall the Windows IIS service 
before trying again.  Please note that if re-installation of the Windows IIS service after 
.NET 3.5 installation is desired, this will require a Windows XP System CD. 
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To uninstall the Windows IIS service, do the following: 
 
1) Select Start->Settings->Control Panel 
2) Double-click "Add or Remove Programs" 
3) Click on "Add/Remove Windows Components" in left pane  
4) Uncheck the "Internet Information Service (IIS)" box 
5) Click Next button 
6) Click Finish button 
 
Please be aware that if DotNet 3.5 is not installed on your machine, PGRemote will NOT 
run at all (nothing will happen at launch -- no windows, warnings, or errors will appear).  

2.3 Setting up the PG3A Module and Probes 

2.3.1 PG3A Installation 
Install the PG3A module following instructions in the PG3AUsersManual, connecting 
the host computer to the module via a USB cable.  For MIPI testing, a single P331 MIPI 
probe needs to be connected to the PG3A.  Note, for the purposes of this document, 
references to the P331 probe also applies to the P332 probe as well (as the only difference 
beween the two probes is the maximum supported HS ). 

2.3.2 P331 Probe Connection 

For a P331 configuration (see Figure 1), a single P331 probe needs to be connected to 
the A and B connectors of the PG3A.  Connect the left connector of the P331 to 
connector A on the PG3A and the right connector of the P331 to connector B on the 
PG3A.   
 
In this configuration, the P331 always sources the master clock to the PG3A and thus, an 
Inputs probe is always required.  Use the CkP/CkN signals from the P331 as the input 
source to the Inputs probe and connect the probe to the PG3A.  Figure 2 shows the 
P331 back panel connectors for reference.  
 

 
Figure 2 – P331 Back Panel 

 
The event signals are available for user diagnostics and monitoring, and are currently 
assigned as follows: 
 

• Evt1 – pulses high when a command is inserted into vertical blanking during 
video mode (see section 3.6.2) 
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• Evt2 – asserts high when any of the four LP contention states are detected (see 
section 0) 

• Trig – reserved 
 
On the front-panel of the P331 are eleven SMA connectors: five differential outputs for 
four data lanes and a clock, as well as the Opt. Clock input.  The Opt. Clock input is 
connected when external clocking is desired, whether for impaired clock testing or to 
make DPhy lane timing synchronous with other devices.  When “External” clocking is 
selected in the PG configuration dialog of PGRemote, the Opt. Clock is output directly as 
the DPhy lane clock, and, in addition, a filtered version of the Opt. Clock input is used 
for data clocking. 

2.3.3 Clock/Data Timing Adjustment 
Regardless which clocking scheme is used, the data and clock must be adjusted to have a 
specific alignment relative to each other.  Generally, users want an ideal quadrature 
sampling relationship between the clock and data, where the lane clock is delayed by 90 
degrees relative to the data.  For example, a lane clock of 300 MHz (600 MBit/s) will 
likely want the clock delay to be set to around 830 ps to center the clock edge properly 
with respect to the HS data.  Note that the maximum lane delay/skew adjustment is 2.4 ns 
for the P331.  Thus, only at lane clock frequencies above 104 MHz can the ideal 
relationship be achieved, and below 104 MHz the timing range cannot cover all possible 
timing relationships.4 
 
Adjusting clock lane timing relative to the data lanes is achieved using the delay 
adjustment controls in the PG Configuration window of the PGRemote application 
(section 3.4.1).  The P331 probe supports a “Real-time Adjust Mode” activated from the 
PG Configuration dialog (see section 3.4.1) that causes all lanes (including clock) to 
output a high-speed 101010… clock pattern.  When this mode is active, delay 
adjustments take effect immediately rather than only when the dialog is closed.  
 
Thus, the procedure for skew adjustment is simply to connect the clock and one data lane 
(all data lanes should be aligned) to an oscilloscope (or using MagniVu capture on the 
TLA) and adjust the HS clock timing as desired.  Generally, HS data lane timings do not 
need adjustment except for advanced testing.  Note also that, for the P331, LP lane delays 
are the same as HS lane delays. 
 
 

                                                 
4  When using external clocking with the P375 probe, end-to-end clock delays through the PG will 
position output data at an arbitrary phase relative to the external lane clock.  Thus, delay/skew adjustment 
requirements to achieve ideal timing may be different than for internal clocking. 
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3 Using PGRemote 
The PGRemote software is the principal application that users interact with to configure 
and send DSI/CSI commands to their DUT.   
 

 
 

Figure 3 – PGRemote Main Window 

3.1 Software Architecture Overview 
Most of the interaction between the user and the MIPI test system occurs in the 
PGRemote main window (see Figure 3).  It has several distinct sections.   
 

• The left pane of the main window allows the user to define MIPI commands and 
their arguments, naming them to allow for later recall and sending to the PG, as 
well as assigning them to command buttons.   
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• The right pane of the main window consists of 30 command buttons that can each 
be individually associated with a defined command, allowing single-click sending 
of command commands to the PG.   

• The bottom left pane of the main window provides controls for configuring 
parameters of PG playback, MIPI protocol definitions, and physical 
characteristics of the DPhy bus. 

• The bottom right pane of the main window comprises PG and probe status and 
operational controls. 

• The status bar at the bottom of the main window displays informational and error 
messages and indicates the current PG host connection. 

 
The following sections describe more details of PGRemote operation. 

3.2 Quick-Start Summary 
The following summarizes the overall procedure for installing and configuring the TMPC 
software and hardware for MIPI testing: 
 

1) Install and connect a PG3A module to a PC (via USB). 
 
2)  Attach a P331 probe to the A/B connectors of the PG3A.   
3)  Connect an Inputs probe to the PG3A and connect the CkP/CkN square pin 

outputs from the back panel of the P331 (see Figure 2) to the clock input of the 
Inputs probe. 

4)  If external clocking is to be used, connect an external clock to the Opt. Clock 
input on the front panel of the P331. 

5)  Connect the SMA data and clock lane outputs from the P331 to the DPhy lane 
inputs of the DUT (or scope if performing timing skew adjustments). 

6)  Apply power to the P331 probe. 
7) Install the PGAppDotNet server application (section 2.1). 
8) Obtain the appropriate TMPCLicense.txt file and copy it to the PGAppDotNet 

application directory (c:\Program Files\TMPC\PGAppDotNet\PGAppDotNet). 
9) Install the PGRemote control application (section 2.2). 
10)  Start the PGAppDotNet server and connect to the PG3A module as the Master 

Module (File->Choose PG…). 
11)  Start the PGRemote application and connect to the PGAppDotNet server (section 

3.3) 
12)  Configure PG operational parameters (section 3.4.2). 
13)  Configure options for the PG, e.g. voltage levels (section 3.4.1) 
14)  Set and/or adjust the clock/data timing skew relationship (section 2.3.3). 
15)  Configure video timing parameters for your device (section3.6.3) 
16)  Define commands and assign them to buttons, if desired (section 3.7).   

 
Once these steps are completed, the system is ready to start testing. 
 
For demonstration without a real PG3A module, a simplified procedure can be used 
starting at step 7 above, with the following modifications: 
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1) Step 8 may be skipped.  When running in offline mode, all MIPI protocol options 

are automatically enabled. 
2) In step 10, when connecting to a PG module, select “Offline” as the Master 

Module. 
3) In step 11, if you are running recent versions of PGAppDotNet and PGRemote, 

PGRemote will automatically configure offline modules to have a P331.  
Otherwise, you need to manually configure your offline module to have a P331 
probe as follows.  Go to the Probe Setup Window and set the probe type of the A 
probe to P331.  To do this, in the System Window, click on the Setup button, then 
the Probe Setup tab, and then click in the A0 Type box in the grid window to 
bring up a drop-down selection box.  Choose P331. 

3.3 Connecting to the PGAppDotNet Server 
Before any MIPI commands can be sent, the PGRemote application needs to connect to 
the PGAppDotNet server, which must be launched before initiating a connection within 
PGRemote.  The appropriate license option (DSI or CSI) must be enabled for your PG3A 
module for the PGAppDotNet server to respond to incoming requests from PGRemote 
(see section 2.1 for details).   
 
Selecting the "Connect" menu option brings up a connection dialog with a textbox to 
enter in the name of the machine where the PGAppDotNet server is running (if both 
PGRemote and PGAppDotNet are running on the same machine the user can leave the 
textbox blank).  After typing the host name, click on the Connect button to connect to the 
server. 
 
An alternate format for the host name can include an IP port number.  The syntax in this 
case is “<hostName>:<portNum>” (note the colon character).  Each PGAppDotNet 
server opens a unique IP port number to use for incoming requests.  The default behavior 
of PGAppDotNet is to first try port number 1025, and, if this fails, try port number 2798.  
PGRemote  PGRemote mirrors this behavior when the user asks to connect to the server: 
first try 1025, then 2798.   
 
Note, in the more unusual case where multiple servers are brought up on the same host 
machine, to bring up a the second corresponding copy of PGRemote, the user must 
specify a proper secondary port number (otherwise, the second copy will connect to port 
1025 like the first copy).    
 
If the connection is successful, the dialog will close and the host name (including port 
number) will be displayed in the center panel on the status bar indicating the current 
connection.  In addition, the PGAppDotNet server will show "Client Connected" in the 
center panel of its status bar. 
 
If the connection is unsuccessful, the problem may be among the following: 
 

1) The host name and/or port number is not correct 
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2) The host is not accessible via the network from the current computer 
3) The PGAppDotNet server is not running 
4) The non-server version, PGApp, is running instead of the PGAppDotNet server.  

To verify, go to the "Help->About PGApp" menu and see that the third line in the 
dialog says "(Dot Net Server Version)". 

 
The "Disconnect" menu is used to close the server connection when testing is complete.  
The application will do this automatically on closing so it is not required.  Once 
connected, the center panel of the status bar will read "Offline", indicating no connection 
to a PGApp server. 
 
Note that on subsequent restarts of PGRemote, the application automatically attempts to 
reconnect to the last PG host used previously.  You can tell if reconnection was 
successful by the second pane of the status window.  If "Offline" is displayed, connection 
was unsuccessful. 

3.4 PG Configuration 

3.4.1 PG Configuration Dialog 
Once connected, the PGAppDotNet server and P331 probe need to be configured with 
parameters specific to your MIPI testing needs.  This is done via the PG Configuration 
dialog brought up from the main window via the "PG Cfg..." button in the lower left pane 
of the main window.   
 
After entering desired settings on the dialog, click the OK button to accept them or 
Cancel if you want to discard them.  Clicking on the “Defaults” button sets all controls to 
their default values for the current probe type selected. 
 
Unless PGRemote is in “real-time adjust mode”, configuration values are only sent to the 
PG after the dialog is closed with the OK button.5  They are also automatically saved and 
restored as application settings when PGRemote is closed and restarted.  Values are 
subsequently sent to the PG on reconnection to the PGAppDotNet server.  Note that 
PGRemote overrides any manual adjustments the user has made to these settings in the 
variable probe window of PGAppDotNet.   
  
Figure 4 shows the PG Configuration dialog.  Below is a description of its controls:   
 

                                                 
5  Clicking the Cancel button in the PG Configuration Dialog will, in general, discard any changes 
and not configure the PG and probe.  However, if changes were made in real-time adjust mode, clicking the 
Cancel button will configure the PG and probe, restoring settings back to their original state. 
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Figure 4 – PG Configuration Dialog 
 
Probe Type:  At the top is a drop-list control for the user to indicate which probe type is 
to be used for this session.  As the probe type is central to entire system operation, this 
selection affects controls and functions throughout the PGRemote application (e.g. 
voltage/delay limits, frequency range, etc.).  Thus, the user should always select the probe 
type first.6  Since the use of the P375 probe is now unsupported, only the P331 probe is 
currently available in this control. 
 
Real-time Adjust Mode: this check box, when checked, cause voltage and delay 
adjustments to take effect immediately rather than wait until the dialog is closed.  This 
                                                 
6  Because PGRemote can operate without a server connection, it must be told what the probe type 
is rather than query the PGAppDotNet server.  Clearly, the probe type setting must match the actual probe 
type connected to the PG3A and PGRemote will notify the user when the PG is configured that there is a 
probe type mismatch. 
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mode is often used with a looping command or video (or the Force Clock Pattern control) 
while monitoring the MIPI signals with a scope.  The procedure to do this is as follows: 
 

1) Send a video command or loop a non-video command.  
2) While the PG is running, click on the PG Cfg... button to bring up the PG 

Configuration dialog.  
3) Click on the "Real-time Adjust Mode" check box.  
4) When asked whether to stop the PG, click No.  
5) Now any adjustments you make will take effect immediately.  
6) When you are done with all your testing, click Cancel on the dialog (otherwise, 

clicking OK will stop the PG). 
 
Force Clock Pattern: checking this box causes a test clock pattern lane (at the current 
HSFreq setting in the main window) to be output on all P331 probe lanes (plus the clock 
lane). This pattern is generally used in conjunction with real-time adjustment and an 
oscilloscope to visually adjust the setup and hold time of the clock lane with respect to 
the data lanes at the DUT. 
 
All HS Common: this check box, when checked, disables the HS voltage controls for all 
lanes except for data lane 0.  Adjustments to data lane 0 HS voltages are automatically 
applied to all lanes.  Otherwise, HS voltage settings can be independently adjusted. 
 
HS Low/High Voltage Controls: these controls set the unterminated HS voltage levels 
for data and clock lanes.  When connecting to real hardware, HS voltages generally 
should be set to 0.0V (low) and 0.4V (high).  Slave termination resistance will reduce HS 
levels to the expected swing of 0.1 - 0.3V.  For the P331 probe, voltage limits are -0.6V 
to 1.2V. 
 
HS Delay Controls: these controls set the relative delays of each lane.  Delay 
adjustments are in ps and have a range of 0 to 2400 ps.  For the P331 probe, HS and LP 
delays are common, so adjusting the HS lane delay sets the LP lane delay and vice-versa.  
Note that the HS (and LP) delay control for the P331 clock is disabled when in external 
clocking mode.  In this mode, clock delay adjustments relative to the data can only be 
made by adjusting the all the data lane delays by the same amount. 
 
All LP Common: this check box, when checked, disables the LP voltage controls for all 
lanes except for data lane 0.  Adjustments to data lane 0 LP voltages are automatically 
applied to all lanes.  Otherwise, LP voltage settings can be independently adjusted.  For 
the P331 probe, this box is always checked. 
 
LP Low/High Voltage Controls: these controls set the LP voltage levels for data and 
clock lanes.  When connecting to real hardware, LP voltages generally should be set to 
0.0V (low) and between 1.1V and 1.3V (high).  For the P331 probe, the low voltage is 
always set to 0.0V and the high voltage limits are 0.45V to 3.6V.   
 



The Moving Pixel Company PGRemote User’s Manual – Doc. Rev. 2.0 -- 6/10/13 

- Page 13 - 

LP Delay Controls: these controls set the relative delays of each lane.  Delay 
adjustments are in ps and have a range of 0 to 2400.  In the P331 probe, HS and LP 
delays are common, so adjusting the LP lane delay sets the HS lane delay and vice-versa.  
Note that the LP (and HS) delay control for the P331 clock is disabled when in external 
clocking mode.  In this mode, clock delay adjustments relative to the data can only be 
made by adjusting the all the data lane delays by the same amount.  
 
LP Contention Thresholds: these two controls are enabled only for the P331 probe and 
determine the threshold voltage used for contention detection.   
 
The LP Low contention threshold determines the voltage at which a LP Low fault is 
flagged (i.e. when the transmitter attempts to drive an LP0 and measures a voltage on the 
line greater than the threshold).  This value is nominally 0.45V according to the DPhy 
specification.   
 
The LP High contention threshold determines the voltage at which a LP High fault is 
flagged (i.e. when the transmitter attempts to drive an LP1 and measures a voltage on the 
line less than the threshold).  This value is nominally 0.55V according to the DPhy 
specification. 
 
BTA Wait Time:  this legacy control is always disabled since the P375 probe is no 
longer supported for MIPI.  Note that the P331 probe responds properly to BTA return 
sequences so this field is unused.   
 
Clk Mode: selects the clocking mode of the PG or probe.  For the P331 probe, this 
setting determines whether the lane clock is internally generated (Internal mode) or 
sourced by the Opt. Clock input of the probe (External mode).  In external mode, the Opt. 
Clock input is passed unaltered to the lane clock output and is filtered to for use in 
clocking data output, allowing for the use of an impaired clock to be used for testing.  
Note that regardless of clock mode setting, the PG is configured to run in external 
clocking mode, as it receives a gated 300 MHz clock from the P331 probe via the Inputs 
probe. 

3.4.2 PG Configuration Controls in Main Window 
In addition to the settings from the PG Configuration dialog, four controls at the bottom 
of the main window are used to describe DPhy configuration parameters.  These controls 
are described below: 
 
DT Mode: this combo box sets the default data transfer mode for commands whose DT 
Mode field is set to “Default”.  Packets may be sent as either HS packets (HSDT mode) 
or LP packets (LPDT mode).  Individual commands can override the default DTMode 
setting by setting the DTMode field in their command arguments.  Note: this mode only 
applies to non-video commands and does not affect video mode operation or low-level 
DPhy commands such as BTA, Trigger, etc.   
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HSFreq: this control sets the lane clock frequency of the DPhy bus.  If clocking is 
external, this value is still necessary to inform the software what frequency the external 
clock will be running at (additionally, the P331 probe must have this information to 
properly condition its Opt. Clock input).   
 
Note that since HS data transitions on both clock edges, the bit rate of each lane will be 2 
* HSFreq and the total bit-rate of the link will be (LaneCnt * 2 * HSFreq).  For the P331, 
the maximum frequency is 580 MHz (1.16 Gbps)7 and the minimum frequency is 1 MHz 
(internal) or 25 MHz (external).  The maximum P332 frequency is 750 MHz (1.5 Gbps).   
 
An exception to the normal behavior of this control is when the user is either using the 
CSI command set or is using the DSI command set and has set the Burst Mode to “Non-
burst” in the current timing configuration (see section 3.6.1).  In these cases, whenever 
the current displayed command is a video command, the HS Freq control becomes read-
only and reflects the frequency that will be used when the command is sent to the PG.8  
The computed frequency takes into account all of the current timing settings as well as 
the lane count. 
 
Finally, because LP and HS data are stored together as PG vectors and, in the case of the 
P331, LP and HS bits are multiply packed into vectors, the frequency of LP bits cannot 
be set independent of the frequency of HS bits.  Thus, whenever the HSFreq setting is 
changed, the LPFreq setting is newly quantized to the nearest legal value and a message 
is displayed in the status window.     
 
LPFreq: this control sets the frequency that LP bits are output onto the DPhy bus (i.e. 
determines T(LPX) in the DPhy standard).  As the PG vector rate is based on HSFreq, 
setting LPFreq effectively determines the number of times each LP data bit is replicated.  
Because of this, as discussed in the description for HSFreq, whenever the LPFreq setting 
is set, the value is quantized to the nearest legal value based on HSFreq.9  
 
Lane Cnt: this control selects the number of DPhy lanes to use (1-4). HS data is 
demultiplexed onto DPhy lanes according to the protocol specification.  Unused lanes are 
held in the LP11 output state. 

3.5 DPhy Timing Configuration 
The DPhy Timing Configuration dialog is brought up via the “Config DPhy Timing” 
menu item in the Options menu.  This dialog allows the user to set DPhy timing 
parameters, most pertaining to the timing of clock and data transitions from LP to HS and 
from HS to LP mode.  In general, the default DPhy parameter values computed by the 

                                                 
7  Requires P331 probe firmware version 1.4 or greater.  Otherwise, the maximum bit rate for the 
P331 probe is 1 Gbps. 
8  Note this behavior also occurs when the mouse hovers over a command button that is assigned to 
a video command and “Display Command on Button Hover” is checked in the Options menu. 
9  The formula for LPFreq quantization is dependent on probe type and HSFreq.  It can take one of 
the forms: HSFreq/1 (at low frequencies), HSFreq/2 (P375 use or moderate frequencies), or HSFreq/4 (at 
high frequencies) 
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system are sufficient and customizing these values is unnecessary.  However, some users 
would like to have the ability to set these parameters more specifically. 
 
DPhy parameter values and the settings from this dialog are saved as application settings 
when PGRemote is exited.  As with other application settings, they are restored when the 
application is restarted. 
 
Figure 5 shows the dialog’s simple layout, with a Configuration drop-down box for 
selecting among timing parameter sets, a left column of text boxes for viewing/setting the 
parameters, and a right column of read-only text boxes for viewing the quantized 
parameters actually used by the PG.  Values are quantized for use by the system based on 
the current HS clock frequency and is required due to internal data packing constraints of 
the PG (and P331 probe). 
 
 

 
Figure 5 – DPhy Timing Configuration Dialog 

 
The Configuration drop-down box always contains at least two options: 
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System Computed Timing: this option is the default setting of PGRemote.  When 
selected this option disables custom editing of all parameters and requests that PGRemote 
automatically compute reasonable defaults.  These defaults depend on and change with 
the current HS clock frequency.  When this option is selected, the default settings for the 
current HS clock frequency are displayed in the read-only parameter boxes. 
 
<new timing>: this option enables and fills in the left column parameter boxes with the 
current default settings.  The user can then change values to create custom timing settings 
to use for all subsequent commands.  Once a parameter is changed, the configuration 
name changes to <custom>.  Please be aware that many DPhy timing parameters have a 
valid range dependent on HS clock frequency.  Since custom values are do not change 
with clock frequency, some custom timing values will be valid only for a specific range 
of HS clock frequencies.  No check is made by PGRemote for the validity of custom 
parameters with respect to the DPhy specification. 
 
Other options in the Configuration drop-down box (if any) are those defined in the 
DPhy.Config text file (if present) located in the application directory. 
 
Once a configuration has been selected, and values edited if desired, click OK to accept 
the new DPhy configuration settings and close the dialog.  Otherwise, click Cancel to 
discard any changes and close the dialog.  

3.5.1 DPhy.Config File Syntax 
Default DPhy timing configurations available in the Configuration drop-down box of the 
DPhy Timing Configuration dialog are loaded from a user-editable text file when the 
dialog is displayed.  This file is located in the PGRemote application directory and is 
called: 
 

 c:/Program Files/TMPC/PGRemote/DPhy.Config 
 
It is probably helpful to start with an existing DPhy.Config file when creating a new one. 

 
The following rules are used to parse the DPhy.Config file: 

• Each line is either a comment line, blank line, or a parameter line. 
• A comment line begins with “//” and is ignored by the parser. 
• A blank line consists solely of spaces or tabs and is ignored by the parser. 
• A parameter line has the format “<name> = <value>”.   
• Table 2 describes the parameter names that are supported.  Names are case 

insensitive. 
• Multiple timing configurations can be defined in the file.  For each timing 

configuration in the file, the “Name” parameter must occur before any other 
associated parameters.  

• Parameters not included default to the system default for the current HS clock 
 

Table 1 – DPhy.Config File Parameters 
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Parameter Description 
Name Defines a new timing configuration with the given name.  

Names may contain any alphanumeric character (no spaces, 
tabs, or equal signs) 

HSPREPARE Time to drive LP00 before starting HS burst (data lane) 
HSZERO Time to drive HS0 before sync sequence (data lane) 
HSEXIT Time to drive LP11 following HS burst (data lane) 
HSTRAIL Time to drive flipped differential state after last HS payload 

bit (data lane) 
CLKPREPARE Time to drive LP00 before starting HS clock (clock lane) 
CLKZERO Time to drive HS0 before sync sequence (clock lane) 
CLKTRAIL Time to drive HS0 after last HS clock (clock lane) 
CLKPRE Time to drive HS clock before any HS data lane transitions to 

HS mode (clock lane) 
CLKPOST Time to drive HS clock after last HS data lane has 

transitioned to LP mode (clock lane) 
TAGO Time to drive LP00 before releasing control during BTA. 
WAKEUP Time to drive Mark-1 state prior to Stop on exit from ULPS. 

 

3.6 Video Mode 

3.6.1 Overview 
PGRemote operates the PG in a special mode called video mode when the user sends a 
video mode command.  Video mode commands are DSI commands whose packet type is 
one of the pixel stream commands or any of the pixel data CSI commands (i.e. RGB, 
YUV, Raw, etc).  Video mode commands are treated differently than non-video mode 
commands in that they cause PGRemote to build an entire DPhy packet stream 
representing one or more video frames, having the appropriate timing and structure 
according to the MIPI protocol standard.  The video sequence can be played once or 
looped continuously to provide ongoing real-time video appropriate for testing of DSI 
displays or emulation of CSI camera chips.  Note that all supported YCbCr formats 
currently implement only progressive frame construction. 
 
All video mode commands accept a single DataFileName argument to specify a file 
containing the video frame data to send.  To send a video sequence of more than one 
frame, this file has a special naming convention to allow PGRemote to derive the file 
names for subsequent frames in the sequence (see section 3.10.4.1).   
 
Before sending a video mode command, additional parameters of video mode playback 
must be appropriately configured using the Frame Timing dialog (see section 3.6.3).  
These timing parameters, like other application settings, are saved and restored in an 
application configuration file when PGRemote is closed and restarted.  
 
Once a video command has been defined and the timing configuration parameters have 
been set, sending the command initiates the sending of video data.  The internals of how 
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video frames are constructed is described in section 3.6.7.  Once video frame packets 
have been built, sent to PGAppDotNet, and downloaded to the PG3A hardware, video 
begins playing on the DPhy bus. 
 
If the ‘Play Mode’ parameter is set to ‘Continuous’, the video frames are played and 
looped indefinitely, stopping only when the ‘PG Abort’ button at the bottom of the main 
window is pressed.  When the PGRemote aborts the PG playback sequence, the PG 
completes a full loop of the sequence before returning to the LP11 quiescent state. 

3.6.2 Command Insertion 
If continuous looping is specified in the timing configuration, the PG will continue 
playing video packets indefinitely.  To send another command, generally the “PG Abort” 
button should be sent to cleanly stop the PG from playing video and return to the 
quiescent LP11 state.  Unless command insertion is enabled (see next paragraph), if a 
command is sent while video is playing , PGRemote will ask you whether you want to 
stop the PG to allow the sending of the command. 
 
Command insertion is a special mode that allows non-video, non-read, non-macro 
commands to be sent during the vertical blanking of a video frame without stopping the 
PG or interrupting the video stream.10  This function is enabled using the “Enable 
command insertion” option (Options menu).  If this option is checked, a command sent 
while video is playing is automatically inserted into the video stream (during the first 
vertical blanking line).  Note also that the insertion event is reflected on the Evt0 signal 
of the P331 back panel (see Figure 2), allowing for instrument trigger at the point of 
command insertion. 
 
The inserted command may be sent in HSDT or LPDT mode and will inherit the LPFreq, 
HSFreq and LaneCnt parameters used for video playback. 

3.6.3 Frame Timing Dialog 
The “Timing Cfg…” button in the main window brings up a dialog to set your MIPI 
device frame timing parameters.   The parameters in this window are used to configure 
video playback when one of the four DSI Pixel Stream commands are sent 
(corresponding to the four different RGB color packing formats) or when one of the 
numerous CSI Pixel Stream commands are sent (RGB, YUV, Raw, etc.)   
 
Depending on the current MIPI protocol (DSI or CSI) the dialog will look a little 
different.  Figure 6 shows the DSI layout of the Frame Timing dialog: 

                                                 
10 Note that command insertion has been extended to work in looping macros as well using the “Cmd 
Insertion Point” packet type (or CMD_INSERTION_POINT RPC command).  
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Figure 6 – Frame Timing Dialog (DSI) 

 
• Controls in the top part of the window specify horizontal and vertical blanking 

component dimensions as well as the active dimensions of the frame.  Read-only 
H and V totals are automatically computed as values are entered.   

 
• Controls in the center-right of the window let you specify the pixel clock timing 

in four different ways, via: line time duration, pixel clock frequency, frame rate, 
or lane clock frequency (if enabled).  Entering a value in one of these four 
controls automatically updates the other three.  

 
• The MinLaneClk text box provides the lane clock frequency required to support 

the current timing configuration.  This value will be dependent on the current 
timing settings, the current PktType setting in the main window (indicating the 
video format) and the LaneCnt.  If the current PktType is not a video command, 
MinLanClk displays “N/A” and the text box is disabled.  Otherwise, the text box 
is enabled, allowing the user to enter in an HS frequency.  Note that if the Lane 
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Count is subsequently changed, the MinLaneClk frequency will change along 
with it (keeping the line time, pixel clock, and frame rate constant).  

 
• The “Play Mode” drop-down box selects two playback options: 
 

o Single Seq: the frame(s) defined in the Pixel Stream command 
is(are) played only once.  After playing, the PG returns to its 
quiescent state with LP11 asserted on all DPhy data lanes.   

 
o Continuous: the frame(s) defined in the Pixel Stream command are 

looped continuously.  After the command is complete, the PG remains 
running, looping on the video frames 

 
• The “HSync Mode” drop-down box selects the DSI HSync Mode: 
 

o Events: horizontal syncs in active lines of video frames are conveyed with 
only an HSync Start packet 

 
o Pulses: horizontal syncs in active lines of video frames are conveyed with 

an HSync Start packet, a Blanking packet, and an HSync End packet.  In 
DSI, this option is only available in Non-Burst mode. 

 
• The “Burst Mode” drop-down box selects the burst mode: 

 
o Non-Burst: non-burst mode assumes the DSI clock is just sufficient to 

transmit active lines with no extra bandwidth.  If the clock is set such that 
there is extra bandwidth based on the current horizontal line parameters, it 
is consumed in the horizontal sync pulse width when HSync Mode is set 
to Pulses.  Otherwise, the line time is shortened.  

 
o Burst: burst mode assumes the clock is set faster than necessary to 

transmit the video frame.  Currently, a blanking packet is inserted in each 
line following active video to consume the excess bandwidth.   

 
3.6.3.1 New Video Mode Implementation 
More recently, the DSI video mode implementation has been significantly improved. The 
following summarizes the differences between old and new implementations: 
 

Table 2 – Comparison Between Old and New Video Modes 
Old Version New Version 
Software always tries to implement a 
blanking segment via LP11.   Only if the 
period is too short is an HS blanking packet 
is used.   

The user can identify for each blanking 
period whether it should be implemented 
using LP11 or HS blanking.(or Auto which 
implements LP11 if feasible and HS 
blanking otherwise). 

When LP11 blanking is used, the blanking Blanking periods are always implemented 
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period is always quantized to an even 
number of byte-clocks. 

with the exact length as requested (or an 
error is reported that describes why the 
attempt failed).  This includes blanking 
periods that end on non-integral byte-clock 
boundaries and lane boundaries other than 
zero.  If blanking is implemented with 
LP11, a small HS blanking packet may be 
added at the end of the segment if 
necessary to implement non-zero lane 
boundaries. 

Not all blanking periods can be 
implemented via HS blanking (at least one 
must use LP11 to allow quantization or an 
error is returned). 

If desired, all blanking periods can be 
implemented via HS blanking. 

EoTp is not supported in video mode EoTp is supported in video mode (if 
enabled). 

The HSync period represents the blanking 
time between HSS and HSE, not including 
either packet time.  The HBackPorch 
includes the HSE packet time and the 
HFrontPorch includes the HSS packet 
time.   

The HSync period includes the HSS packet 
time and HBackPorch includes the HSE 
packet time. 

Interlaced formats are not supported. Interlaced formats for all YCbCr modes are 
supported. 

Frame sequences consisting of multiple 
frames cannot be stepped. 

Frames sequences consisting of multiple 
frames can be stepped (i.e. played one-by-
one) using an external event signal (see 
section 3.7.4) 

 
Accordingly, additional controls have been added to the Frame Timing dialog to support 
the new implementation, which are enabled when the “Enable New Video Mode” check 
box is checked (when unchecked, the old video mode implementation is used and the 
new video mode controls are disabled).  Here is a description of the new controls: 
 
The major restriction of both DSI New Video Mode and CSI Video Mode 
implementations is that, generally, PGRemote requires that video lines have an integral 
number of bytes per lane.  However, for DSI, if there are an even number of video lines 
in the frame (VTotal), PGRemote can pair lines together in the PG so that line lengths 
can be a multiple of ½ bytes per lane.11 
 

                                                 
11 This requirement is a PGRemote requirement (not a MIPI requirement) and is due to 
how video is implemented in the PG.  Video lines (or line pairs) are stored in the PG as 
individual blocks which, because of how video data is packed, requires quantization to 
lane byte boundaries. 
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Example:  
 
For a video frame with an HTotal of 1516 pixels in packed RGB 6-6-6 format, there are 
1516 * (18 bits/pixel) / (8 bits/byte) = 3411 bytes in a line.  If you try to send this using 4 
lanes, you will receive an error: 
 

“Error: <file> has invalid height or width for selected format” 
 
This is because 3411 / 4  = 852.75 bytes / lane which is not an integral number of bytes.  
If you send this using 3 lanes, it will be successful, since 3411 / 3 = 1137, an integer.  
Finally, using 2 lanes, sending the video will be successful only if VTotal is even, since 
the number of bytes / lane is 3411 / 2 = 1705.5, an integral number of ½ bytes. 
 
Note that if the video format is RGB888, all lane counts are feasible because there are 
1516 * 3 = 4548 bytes / line, which is divisible byte 1, 2, 3, and 4. 
 
Allow Variable DPhy Timing: to support LP11 blanking periods with half-byte-clock 
resolution the HSTrail and/or HSZero DPhy timing periods may need to be increased by 
a half-byte-clock.  Normally, these timing periods (which are specified in the DPhy 
Timing Configuration dialog) are quantized to integral byte-clocks and do not change 
from segment to segment.  To allow this adjustment as necessary for video mode 
implementation, the user must check this box or an error will be returned for video timing 
configurations that require it. 
 
Turn clock off during LP blanking: selecting this option causes the clock to be turned 
off during LP blanking during video mode.  Otherwise, the clock remains on throughout 
video playback. 
 
Send “Top-Field-First”: selecting this option causes the causes the top-field (i.e. lines 1, 
3, 5…) of the image to be sent before the bottom-field (i.e. lines 2,4,6…) when sending 
interlaced video.  Otherwise, the bottom-field is sent before the top-field. 
 
HSync Blanking: this control allows the user to specify whether to implement the HSync 
blanking period via LP11 or an HS blanking packet.  A third option is “Auto” which 
implements the blanking segments via LP11 unless it is too short in which case the 
segment is implemented with an HS blanking packet.  
 
HBPorch Blanking: this control allows the user to specify whether to implement the 
HBackPorch blanking period via LP11 or an HS blanking packet.  A third option is 
“Auto” which implements the blanking segments via LP11 unless it is too short in which 
case the segment is implemented with an HS blanking packet.  
 
HFPorch Blanking this control allows the user to specify whether to implement the 
HFrontPorch blanking period via LP11 or an HS blanking packet.  A third option is 
“Auto” which implements the blanking segments via LP11 unless it is too short in which 
case the segment is implemented with an HS blanking packet.  
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Vertical Blanking this control allows the user to specify whether to implement the 
blanking periods during Vertical blanking as LP11 or HS blanking packets.  A third 
option is “Auto” which implements the blanking segments via LP11 unless it is too short 
in which case the segment is implemented with na HS blanking packet.  Note that vertical 
blanking lines have one blanking period in “Event” mode and two blanking periods in 
“Pulse” mode (with the HSync End packet in between them).   

3.6.4 DSI Interlaced Modes 
The latest version of PGRemote supports interlace for all the YCbCr video packet types.  
A new parameter called ‘Interlaced” is provided in the argument list for the command.  
Setting this value to ‘1’ enables interlace for the implemented video mode when the 
command is sent. 
 
Note that all of the vertical frame parameters in the frame timing dialog remain as frame-
based settings.  This means the number of lines given for VSync, VBPorch, and VFPorch 
are divided by 2 when implementing each field.  Accordingly, the following restrictions 
are placed on the vertical frame parameters: 
 

• VSync must be even 
• VBPorch must be even 
• VFPorch must be odd 
• VActive must be even 
 

Other requirements are that: 
 

• ‘Enable New Video Mode’ must be checked 
• If pulse mode is enabled, HSync blanking must be less than ½ line 

 
To support the new Interlaced parameter using RPC commands, note that the 
PIXEL_STREAM calls now use arg2 to indicate whether or not interlaced mode is 
enabled. 

3.6.5 CSI Frame Timing Dialog differences 
Figure 7 shows the CSI layout of the Frame Timing dialog.  Basically, the HSync Mode 
and Burst Mode controls have been removed and three new controls have been added: 
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Figure 7 – Frame Timing Dialog (CSI) 

 
• The “Use LS/LE” drop-down box selects Line Start/Line End packet usage: 
 

o Yes: Line Start and Line End packets are inserted into the video stream 
and bracket each active video packet. 

o No: Line Start and Line End packets are not inserted into the video stream. 
 

• The “Frame Numbering” drop-down box selects Frame Numbering usage: 
 

o 0: the frame number parameter in the Frame Start and Frame End packets 
is set to zero. 

o 1,2,3…: the frame number parameter in the Frame Start and Frame End 
packets is set, starting with 1 and incrementing each frame. 

 
• The “Line Numbering” drop-down box selects Line Numbering usage: 
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o 0: the line number parameter in the Line Start and Line End packets is set 
to zero. 

o 1,2,3…: the line number parameter in the Line Start and Line End packets 
is set, starting with 1 and incrementing each line. 

3.6.6 Timing.Config File Syntax 
Default timing configurations available in the drop-down box of the Timing Config 
dialog are loaded from a user-editable text file when the dialog is displayed.  This file is 
located in the PGRemote application directory and is called: 
 

 c:/Program Files/TMPC/PGRemote/Timing.Config 
 
It is probably helpful to start with an existing Timing.Config file when creating a new 
one. 

 
The following rules are used to parse the Timing.Config file: 

• Each line is either a comment line, blank line, or a parameter line. 
• A comment line begins with “//” and is ignored by the parser. 
• A blank line consists solely of spaces or tabs and is ignored by the parser. 
• A parameter line has the format “<name> = <value>”.   
• Table 2 describes the parameter names that are supported.  Names are case 

insensitive. 
• Multiple timing configurations can be defined in the file.  For each timing 

configuration in the file, the “Name” parameter must occur before any other 
associated parameters.  

• Parameters not included for a timing configuration default to 0. 



The Moving Pixel Company PGRemote User’s Manual – Doc. Rev. 2.0 -- 6/10/13 

- Page 26 - 

 
Table 3 – Timing.Config File Parameters 

 
Parameter Description 
Name Defines a new timing configuration with the given name.  

Names may contain any alphanumeric character (no 
spaces, tabs, or equal signs) 

HSync Duration of horizontal sync in pixels 
HBPorch Duration of horizontal back porch in pixels 
HFPorch Duration of horizontal front porch in pixels 
HActive Number of active pixels in line 
VSync Duration of vertical sync in lines 
VBPorch Duration of vertical back porch in lines 
VFPorch Duration of vertical front porch in lines 
VActive Number of active lines 
LineTime Duration of line in microseconds.  Only one of LineTime, 

PixClk, or FrameRate is required in a timing 
configuration. 

PixClk Pixel clock in MHz.  Only one of LineTime, PixClk, or 
FrameRate is required in a timing configuration. 

FrameRate Frame rate in Hz.  Only one of LineTime, PixClk, or 
FrameRate is required in a timing configuration. 

PlayMode Defines how the PG will play video frame(s).  Set to “0” 
for single-sequence or “1” for continuous playback. 

HSyncMode Defines how HSync will be output.  Set to “0” for events 
and “1” for pulses. 

BurstMode Set to “0” for non-burst mode output and “1” for burst 
mode output. 

FrameIncr Set to “0” to set the frame number parameter in Frame 
Start and Frame End packets to 0.  Set to “1” to use an 
incrementing sequence beginning with 1. 

LineIncr Set to “0” to set the line number parameter in Line Start 
and Line End packets to 0.  Set to “1” to use an 
incrementing sequence beginning with 1. 

UseLSLE Set to “0” to disable and “1” to enable Line Start and Line 
End packet insertion. 

Use_New_Video_Mode Set to “0” to use the old DS I video mode implementation 
and “1” to enable the new video mode implementation. 

Allow_Variable_Dphy_Timing Set to “0” to require lines to end on a byte-clock boundary 
and “1” to support lines ending on a half-clock boundary.  
This is accomplished through adjusting the HSZero and/or 
HSTrail timing if necessary on burst entry/exit.12 

Turn_Clock_Off_During_LP_B Set to “0” to keep the HS clock running throughout video 

                                                 
12 Applies only to the new video mode implementation for DSI (i.e. when Use_New_Video_Mode is non-
zero). 
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lanking output and “1” to allow the clock to turn off and on during 
LP11 blanking times (length permitting). 12 

Top_Field_First Set to “0” for the bottom field to output before the top 
field in DSI video interlaced modes.  Set to “1” for the top 
field to be output first. 

HSync_Blanking_Mode Set to “0” or “Auto_Blank_Mode” to implement HSync 
blanking via automatic determination (LP11 if length 
permits, HS blanking otherwise).  Set to “1” or 
“HS_Blank_Mode” for HS blanking and “2” or 
“LP11_Blank_Mode” for LP11 blanking. 12 

HBPorch_Blanking_Mode Set to “0” or “Auto_Blank_Mode” to implement HSync 
blanking via automatic determination (LP11 if length 
permits, HS blanking otherwise).  Set to “1” or 
“HS_Blank_Mode” for HS blanking and “2” or 
“LP11_Blank_Mode” for LP11 blanking. 12 

HFPorch_Blanking_Mode Set to “0” or “Auto_Blank_Mode” to implement HSync 
blanking via automatic determination (LP11 if length 
permits, HS blanking otherwise).  Set to “1” or 
“HS_Blank_Mode” for HS blanking and “2” or 
“LP11_Blank_Mode” for LP11 blanking. 12 

Vertical_Blanking_Mode Set to “0” or “Auto_Blank_Mode” to implement HSync 
blanking via automatic determination (LP11 if length 
permits, HS blanking otherwise).  Set to “1” or 
“HS_Blank_Mode” for HS blanking and “2” or 
“LP11_Blank_Mode” for LP11 blanking. 12 

3.6.7 Video Frame Construction Details 
In contrast to the relatively simple non-video mode commands, video-mode commands 
define numerous blocks and have a more complicated sequence.  A PG block is built for 
each unique line segment, such as the start and end of active lines that have horizontal 
sync and blanking, active line segments comprised of video packets, and several segment 
definitions to build vertical blanking lines.  They are all put together in the sequence to 
play out one or more video frames. 
 
While it is not generally recommended to interact with the PGAppDotNet server while 
PGRemote is connected, in this case it is constructive to send a video command and then 
look at the PGAppDotNet programming, i.e. the blocks and sequence that are created.  
 
DSI frames consist of vertical blanking lines and active lines.  Structurally, lines consist 
of various segments defined by the DSI specification: horizontal sync (HSA), horizontal 
front-porch (HFP), horizontal back-porch (HBP), and active video.  The duration of each 
of these segments (in pixels) is specified in the timing configuration.  
 
In PGRemote, a sync or blanking segment is implemented by HS blanking packet or a 
round-trip transition to LP11 for the required duration.  Blanking segments long enough 
to incur the overhead of the round-trip transition to LP11 use this method.  Otherwise, the 
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interval is implemented with a blanking packet.   Of course, even blanking packets have 
overhead, and so segments must be at least long enough to accommodate the minimum 
length blanking packet. 
 
While the desired timing characteristics of a video line is defined in the frame timing 
dialog, actual timings of may slightly differ.  This is because of the complexity of 
constructing arbitrary packet timing given bit packing and vector alignment of data in the 
PG, as well as the variable overhead associated with DSI/DPhy byte quantization, lane 
multiplexing, and SOT/EOT signaling requirements.   
 
The following summarizes notes for building DSI video frames and lines: 
 

• Frames begin with the start of vertical blanking and end with the last active line in 
the frame. 

• Lines have the following segment order: HSA, HBP, active, HFP. 
• Vertical blanking lines merge HBP and active line segments in to HFP. 
• Blanking segment timing takes into account all packet overhead and/or SOT/EOT 

signaling overhead 
• Any line time adjustments are made to the last blanking segment (HSA, HBP, 

HFP) that is implemented with a transition to LP11 (i.e. not a blanking packet).   
This is because fine-time adjustments can’t be made in a blanking packet.  If no 
such segment exists, video frame construction fails. 

• If HSync Event Mode is true, the HSA segment begins with the HSync Start 
packet and the total duration is the combination of HSA and HBP.  The HBP 
segment is not then implemented. 

• Active packet overhead is subsumed into HBP. 
 

CSI video frame structure is simplified compared to DSI.  The following summarizes 
notes for building CSI video frames and lines: 
 

• Frames begin with the second line of vertical blanking and end with the first line 
of vertical blanking in the frame (which contains the Frame End packet at the 
beginning). 

• Lines have two segments: Blanking and Active (with optional Line Start and Line 
End packets) 

• Blanking segments have total duration equal to the HSA, HBP and HFP segments 
in the timing configuration. 

 
3.6.7.1 Video File Sizes for P331 
In non-burst mode, DSI, the amount of PG memory needed to accommodate a particular 
video format is approximately as follows: 
 

Number of vectors = HTotal * (VActive + 7) * (BitsPerPixel) / (4*LaneCount) 
 
In non-burst mode, CSI, the amount of PG memory needed to accommodate a particular 
video format is approximately as follows: 
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Number of vectors =  HTotal * (VActive + 3) * (BitsPerPixel) / (4*LaneCount) 

 
Conversely, the number of frames that will fit into a PG3A is roughly: 
 
  32,000,000 / (number of vectors). 
 

3.7 Other Special Modes and Behavior 

3.7.1 Clock Lane Behavior 
The DPhy clock lane originally was intended to turn on with the first MIPI command and 
remain on for all subsequent commands (with the exception of ULPS which came later).  
Requests to provide on/off behavior subsequently led to the menu option “Turn clock 
on/off with each command”.  This option applied only to non-video commands and 
treated macros as a single command.  
 
To allow the user for greater flexibility in controlling the clock lane (on/off), two new 
PktType commands have been introduced: “Clock On” and “Clock Off”.  These 
commands perform MIPI conformant transitions between LP11 and HS bits toggling on 
the clock lane.  These commands are generally intended for use in macros, to allow for 
control over the clock during component macro commands. 
 
The following then summarizes behavior and assumptions about the clock lane state 
(these do not apply when in ULPS mode): 
 

• When “Turn clock on/off with each command” is disabled, the assumed state of 
the clock when any command is sent is ON (HS toggling), and the state of the 
clock when commands complete is ON.  

• When “Turn clock on/off with each command” is enabled, the assumed state of 
the clock when any command is sent is OFF (LP11), and the state of the clock 
when commands complete is OFF.  

• If the clock is not in the assumed state when a command is sent, it is 
automatically turned ON or OFF as appropriate before sending the command, 
with one exception.  The exception is: if the command being sent is a macro, and 
the first component command of the macro turns the clock on or off, no automatic 
action is taken.  This avoids, for example, the clock to be automatically turned on 
only to be turned off again by the first component command of a macro. 

• Within a macro, if the clock lane is already ON when a “Clock On” command 
occurs, no action is taken 

• Within a macro, if the clock lane is already OFF when a “Clock Off” command 
occurs in a macro, no action is taken. 

• While the restart command will allow replaying a macro with clock on/off 
commands, the clock lane may not behave as intended if the initial clock state is 
different upon restart as it was when the command was initially sent. 
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A couple implications of the above behavior are: 
 

• The only way to send an LP command with the clock turned OFF is through a 
macro. 

• A macro that ends with a clock on/off command does not guarantee the clock lane 
state after it completes.  This is determined by the option “Turn clock on/off with 
each command”. 

3.7.2 ULPS 
Two commands in the PktType list-box are available for entering and exiting ULPS 
respectively: “Enter Ultra Low-Power State” and “Exit Ultra Low-Power State”.  While 
these commands cannot be added to macros, they can be assigned to buttons and are 
supported via RPC commands as well.   
 
When ULPS is entered, all lanes including the clock lane are put in ULPS according to 
the DPhy protocol.  When lanes are in ULP state, the “Lane Clk” and “Lane Data” status 
in the bottom right of the main window will indicate “ULPS”.   
 
Like continuous video mode, the PG continues to run while the ULP state is held and 
when the PG is stopped, the ULP state is exited.  There are three ways to exit ULP state: 
 

1) Via the “Exit Ultra Low-Power State” command 
2) Via the “PG Abort” button 
3) By sending a MIPI command 

 
In each case, all lanes follow the protocol to exit ULP state.  After exiting ULPS, the HS 
clock lane may start if the “Turn clock on/off each command” option is not selected.  
Finally, in case 3, the MIPI command is then sent.   

3.7.3 External Event Input Triggering 
The option “Run PG on external event” allows users to configure the PG to wait for an 
external trigger event before sending any command (including video mode frames)  
When this option is enabled, commands that are sent to the PG are prepared and sent as 
usual to the PG but instead of the data being sent out, the PG is “Armed” and waits for a 
rising edge (logic level ‘0’ to ‘1’) on event line 0 of the P300 Inputs probe connected to 
the PG.   
 
Once this edge is seen, the command is output.  The latency of the event signal through 
the PG and P331 probe is clock frequency dependent, but should be on the order of 
microseconds. 
 
Independent of this option, the external event input can also be used as a method to pause 
output (held in a specified static LP state) while playing a macro.  The command to use 
for this function is WAIT_EXT_EVENT (PktType = “Wait Ext Event”). 
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3.7.4 Video Sequence “Stepping” Using External Events 
In addition, when the option “Run PG on external event” is used in conjunction with the 
“New Video Mode” DSI implementation, a sequence of video frames can be looped 
individually, one at a time.  The external event is used to advance to the next video frame 
in the sequence.   
 
Conditions to enable this mode: 

1. Run PG on external event" option is selected (Options menu) 
2. New Video Mode is checked in the Timing Configuration 
3. Continuous video mode is selected in the Timing Configuration 
4. A video command containing multiple video frames is sent (i.e. FrameCount 

argument is greater than 1) 
 
When the video command is sent, the PG waits for an initial event before playing the first 
video frame (see previous section).  Then, once the event line 0 of the P300 Inputs probe 
connected to the PG sees a rising edge the first video frame is played indefinitely.  Then, 
when a second rising edge event occurs, the second video frame is played.  Etc.  After the 
last frame in the sequence has played, the sequence starts over with the first frame again. 

3.7.5 Causing Packet Errors 
The PGRemote GUI supports the ability to modify a packet’s ECC and CRC fields to 
cause receive errors in packets.  Normally, when a packet type is selected for a command 
in the main window and its parameters are filled in, read-only fields are displayed 
showing the DataID and ECC for short packets and, additionally, the WordCount and 
CRC for long packets.  Checkboxes next to the ECC and CRC fields allow user 
modification of these fields to cause a receive error in the packet. 
 
To change the ECC or CRC, simply check the associated checkbox, making the field 
value editable.  Unchecking the checkbox, recomputes the correct ECC or CRC value and 
restores the field back to its original read-only state. 
 
Note that this capability applies to all single commands and commands within macros as 
well.  The File command does not break-out ECC and CRC fields (as it can contain 
multiple packets) so this capability is not applicable to File commands.  Similarly, with 
video mode, there is no place for the user set the ECC or CRC of any of the video frame 
packets.   
 
When applied to the WriteMemory commands, if the command is partitioned into 
multiple WriteMemory commands, the user-set ECC and/or CRC applies only to the first 
WriteMemory command.  Remaining WriteMemory commands are always built with 
their correct ECC and CRC.   
 
An additional mechanism for introducing packet errors is described in the description of 
RPC.  In addition to allowing the ECC and CRC to be set, the 
SEND_IMPAIRED_MIPI_CMD RPC call allows any byte in a packet to be XORed with 
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an error mask before it is sent.  Please see the description of this command for further 
information.   

3.7.6 Script Recording 
Script recording is a mode in which MIPI commands sent to the DUT are also written as 
RPC commands to a designated script text file.  All commands, including macros and 
video mode commands are recorded.  After recording, the script file can be sent as any 
other script file or used as a template for creating additional script files.   
 
In addition, the current configuration state can be written to the script file.  This allows 
the script file to initialize PGRemote to a particular configuration or be sent to the 
Moving Pixel Company to document your configuration when requesting assistance. 
 
To enable script recording, select “Start Recording” from the Script menu.  When this 
option is selected, a browse dialog is opened for you to designate the text script file name 
to use for recording. 
 
Once script recording is enabled, the status bar displays the text “Recording” in a new 
pane.  The script file is initialized with a header containing information about the current 
software and hardware configuration.   Here is an example header: 
 

// Script file created 4/3/2012 10:24:44.9838135 
 
// PGRemote version: 1.2.2.0 
// PGAppDotNet software version: 2.00.27 
// PG module serial number(s): 1063  
// PG module firmware revision(s): 1.9  
// PG options:   CSI, DSI, DDR, DIGRF 
// Probe type on module 1, connector A: P331 
// Probe version is: 1.1 

 
Any MIPI command sent (without error) during recording also causes an RPC command 
to be appended to the script file.  In addition, selecting the menu option “Write Current 
State” from the Script menu causes the current state to be written to the script file.  To 
end script recording, select “End Recording” from the Script menu.  

3.7.7 Generic Standard 
The Generic standard option in the Standard menu is not a MIPI standard and is not 
intended to be used with MIPI devices.  Rather it allows the P331 probe to be used as a 
generic high-speed serial probe, outputting data specified by the standard’s only 
command which is the File Command. 
 
The File Command syntax is identical to that used with CSI/DSI standards, allowing the 
use of either ASCII or binary file format.  The ASCII file format has the following 
syntax: 

• A command line begins with “//” and is ignored by the parser. 
• A blank line consists solely of spaces or tabs and is ignored by the parser. 
• The first non-comment, non-blank line should be “#ASCII”. 
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• Subsequent lines define hex data bytes separated by white-space or commas. 
• Any number of hex data bytes are allowed per line. 

 
Example: 

// This is an example ASCII file for the File Command 
#ASCII 
18 04 00 4f 
87 4d 22 8c 

 
If the parser cannot find the #ASCII token in the specified file, it is assumed to be a 
binary file.  In this case, entire contents of the file are considered to comprise a data 
packet or series of packets to associate with the command name. 
 
Though the file format is the same as for the CSI/DSI standards, the interpretation of 
bytes for output is different.  In the generic standard, data bytes are interpreted as a 
stream of bits, ls-bit first.  Then, bits are interleaved across lanes depending on the 
current lane count.  Finally, if the number of bits is not evenly divisible by eight times the 
number of lanes, the last bit is replicated so that each lane has an even number of bytes.   
  
When the command is sent, bits are output serially on lanes at two times HS clock 
frequency (bits are output on both clock edges).  At the end of the command, the last bit 
of each lane will be held on the outputs until the next command is sent. 
 
Example: 
 #ASCII 
 03 f0 80 91 
  
 If LaneCnt == 1, the following pattern will be output on lane 0: 

1 1 0 0 0 0 0 0…     
0 0 0 0 1 1 1 1…     
0 0 0 0 0 0 0 1…     
1 0 0 0 1 0 0 1… 
 

 If LaneCnt == 4, the pattern will be  
1 0 0 1 0 0 1 1… on lane 1 

  1 0 0 1 0 0 0 0… on lane 2 
  0 0 0 1 0 0 0 0… on lane 3 
  0 0 0 1 0 1 0 1… on lane 4  

3.7.8 Dual-video Synchronization 
Special support has been added to PGRemote to support the approximate synchronization 
of video from two full, independent systems (PG3A, P331, PGAppDotNet, and 
PGRemote).  Note this option requires at least firmware version 1.7 on the P331 probes.  
To make use of this support, in both copies of PGRemote, select the “Configure for dual-
synchronized video” menu in the Options menu.  This brings up a dialog with two fields: 
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 Enable Synchronization – check to enable support for synchronization 
 
 Delay after sync – set this floating point field to the number of microseconds to 

delay video start after synchronization.  This allows control over the relative start 
times between the video output from each system. 

 
In addition to enabling synchronization, both copies of PGRemote should have the "Run 
PG On Event" and the "Use External Clock Input On P331 As 10 MHz Reference" 
options checked.   With these options, PGRemote will build in the following behavior 
when video is sent: 
 

The TRIGOUT signal on each PG3A module will pulse high initially then 
immediately wait for an external high signal on the Event0 line of its Inputs 
probe.  When the event occurs, both P331 probes are reset to an 
approximate known state, causing subsequent data to be output in near 
synchrony (less than 1 us).   

 
As indicated, this mode requires two full PG systems (PG and P331) as well as two 
PGAppDotNet and PGRemote instances running.  To bring up two versions of 
PGAppDotNet, you can just start them in sequence.   The first will default to port 1025 
and the second will default to port 2798.  Next bring up two versions of PGRemote.  
Then connect to the servers  making sure you specify which server port to use with the 
syntax <hostName>:<portNum> (see section 3.3 for more information). 
 
For ease of use, the 10 MHz reference clock output (REFOUT) from the master PG can 
be tee'd and connected to both P331 external clock inputs.  In addition, the TRIGOUT 
output from the master PG can be tee'd and connected to event 0 of both PG's Inputs 
probe.  
 
Once configured, video is sent in both instances of PGRemote, first in the slave 
PGRemote, then in the master PGRemote.  The slave will download and initialize but 
wait in the LP11 state for the master to start.  When the master starts, both will start 
outputting video, nearly synchronized. 

3.8 Customizing GUI Colors 
In the PGRemoteForP338 application, the user can configure the colors of various 
elements of the GUI (e.g. the background and foreground colors of buttons, forms, 
menus, etc).  This is achieved using the Color Options dialog, brought up via the Options 
menu by selecting the “Set Colors” menu item.   
 
The Options dialog (see Figure 8) consists of a column of buttons on the left showing the 
current color settings of GUI controls.  In the center of the dialog is a color square 
showing all the colors associated with a given luminance.  Clicking and dragging the 
mouse inside of the color square will select the color of the currently selected control. 
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Figure 8 – Color Options Dialog 

 
The luminance can be changed by adjusting the slider labeled ‘Y’.  Alternately, you can 
change the R, G, B color components using the sliders on the right of the color square.  
Yet another way to change the color is to click on a control button color (far right 
column).  This loads the selected color as the current color.  For example, to set the 
Button foreground the same as the Form foreground, click the Button FG radio button 
and click the color button next to the Form FG button. 
 
As the control color changes, the main window colors will change in real time, so you 
can see how colors interact.  To restore the default colors, click on the Defaults button.  
When you are done changing colors, to accept the new colors, click the OK button.  To 
discard your color changes, click the Cancel button.  Color settings are saved on 
application exit and restored when the application is restarted. 

3.9 Menus 
This section outlines the menu commands available in PGRemote: 
 

• File: 
o Load – loads a previously saved command configuration file, overwriting 

any current commands and button assignments. 
o Save <fn> -- saves the current command definitions and button 

assignments from both the CSI and DSI protocol sets to the current file 
<fn>.  Note that the command configuration file does not store application 
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settings, which includes PG configuration and Timing configuration 
settings.  

o Save <fn> As… -- same as the Save <fn> command above except a 
dialog appears to browse and enter a new configuration file name. 

o <recent files> a list of the four most recent configuration files.  Selecting 
one of these file names loads the file. 

o Clear Recent File List – clears the most recent file list 
o Send Cmd To File – send the current command as ASCII bytes to a file 

(allowing it to be modified and sent using the File Command packet type).  
Note: this option is only enabled for non-video, non-macro, non-DPhy 
commands when connected to a licensed PG. 

o Exit – exits the application 
• Connect: 

o PG Connect… – brings up the PG connection dialog (see section 3.3) 
o PG Disconnect – disconnects from the current PGAppDotNet server, 

leaving PGRemote in offline mode. 
o Enable RPC – when checked, enables PGRemote to accept and process 

incoming RPC requests (see section Error! Reference source not 
found.).   

• Standard: 
o DSI – selects the DSI command set and button assignments 
o CSI – selects the CSI command set and button assignments 
o Generic – selects the Generic command set and button assignments. 

• Options: 
o Turn clock on/off each command – this option is enabled only for the 

P331 probe.  If checked, every time a command is sent, the clock lane 
begins in LP11 mode and transitions to HS mode (according to the DPhy 
specification) before the command is sent.  After the command is sent, the 
clock lane transitions back to LP11 mode.  If this option is not checked, 
the clock lane will be left oscillating in HS mode for continuous clock 
operation.   

o Display command on button hover – if checked, this option causes the 
command assigned to a button to be displayed in the left pane temporarily 
when the mouse hovers over the button.  The left pane reverts to its 
current settings when the mouse leaves the button. 

o Enable command insertion –if checked, a non-video, non-macro, non-
read command sent while a video mode is looping is automatically 
inserted (once) into the vertical blanking interval without stopping video 
playback.  If unchecked, sending any command while a video mode 
command is looping causes PGRemote to ask whether you wish to stop 
video playback to send the command.  This function has been extended to 
work with a looping macro containing a command insertion point. 

o Enable EoT packets – this option, when checked, causes EoT packets to 
automatically be appended to non-video HS bursts. 

o Disable Command Timeout – this option, when checked, disables the 
normal timeout for non-video commands.  This timeout, which is set to 



The Moving Pixel Company PGRemote User’s Manual – Doc. Rev. 2.0 -- 6/10/13 

- Page 37 - 

about one second, causes the PG to abort output (exactly as if the user 
pressed the Abort button).  This option is particularly useful for macros 
that include BTA or BTA_WAIT commands, which can cause arbitrary 
delays based on the testing environment and the behavior of the device 
under test. 

o Loop non-video commands – this option causes any non-video command 
or macro that is sent to be looped indefinitely.  For HS commands, a short 
period of LP11 occurs between iterations.  Similar to continuous video 
mode, looping can be stopped using the PGAbort button.  Generally, this 
option is used for low-level debugging and so is not saved/restored with 
other application configuration settings. 

o Run PG on external event – this option, when checked, configures the 
PG to wait for an external event on its P300 Inputs probe before 
continuing to output the data for a command.  When event line 0 is a logic 
‘0’, the PG waits until it goes to ‘1’ before continuing (see section 3.7.3 
for more information).  Note that the external event can also be used to 
control macro output using the “Wait Ext Event” packet type. 

o Use external clock input on P331 as 10 MHz reference – this option 
allows the user to connect an external 10 MHz clock source to the P331 
“Opt Clk In” input to be used as the reference clock for the data output 
frequency.  Note this function requires at least P331 firmware version 1.7. 

o Don’t force LP11 after command – this legacy option is always disabled 
(since the discontinuation of support for the P375 probe for MIPI). 

o Send single packet per HS burst – this option is currently enabled only 
for the CSI standard and affects all composite commands, including 
macros, multiple packets in a File Command (if legally parsible), and 
video mode commands.  Normally, these commands send consecutive HS 
packets in a single HS burst.  However, when this option is checked, each 
HS packet is sent in its own HS burst. 

o Use only LP11 for video blanking – this option is enabled when “Send 
single packet per HS burst” option is checked.13  In video frames, blanking 
can be implemented with either the LP11 state or a HS blanking packets.  
The default PGRemote implementation chooses whichever method is 
convenient (often depending on how long the time to assert blanking is).  
When this option is checked, video blanking is built solely using the LP11 
state. 

o Configure DPhy Timing… – selecting this menu option brings up the 
DPhy Timing Configuration dialog, allowing the user to enter custom 
DPhy timing parameters, most pertaining to the timing of clock and data 
transitions from LP to HS and HS to LP mode.   

o Configure WriteMemory commands…  – this option brings up the 
ConfigWriteMemory dialog for configuring whether and how a long DCS 

                                                 
13 While the two options “Send single packet per HS burst” and “Use only LP11 for horizontal blanking” 
are not functionally related, they are implemented using a common subroutine.  Thus, the second option is 
only available if the first option is used. 
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WriteMemory command is partitioned into multiple WriteMemory 
commands (see section 3.10.4.4 for more information). 

o Configure for dual synchronized video… – this option brings up a 
dialog for synchronizing the video for two full, independent systems 
(P331, PG3A, PGAppDotNet, and PGRemote).   

o Set Colors… – this option is only available on PGRemoteForP338.  When 
selected, the Color Options dialog is shown, allowing the user to change 
colors of various elements of the GUI.   

• Script 
o Start Recording – begins a script recording of MIPI commands sent to 

the DUT.  See section 3.7.6 for more details. 
o End Recording – ends script recording.  
o Write Current State -- writes all configurable state as RPC commands to 

the current script recording file (this options is only enabled during script 
recording).   

• About 
o Help – displays this manual as a help file 
o About – brings up a summary window displaying the current software 

version.  This dialog also includes a summary of release notes of 
changes/fixes for each version. 

3.10 Commands 

3.10.1 Defining a New Command 
Commands are defined using the left pane controls of the main window and are grouped 
according to MIPI protocol.  Thus, before defining a command, the user should select the 
desired protocol via the Standard menu, currently either CSI or DSI.  Then, to define a 
new command, perform the following steps: 
 

1) Select the command type via the PktType ComboBox.   
2) If the command type is a DCS command from the DSI command set (i.e. DCS 

Short Write, DCS Long Write, or DCS Read Request), the DCSCmd ComboBox 
will be enabled.  Select the DCS command type from this control. 

3) Depending on the command selected, argument fields will be labeled and enabled 
for the user to enter values. Certain arguments are pre-filled such as the virtual 
channel, DT Mode, and BTA.  The user may change these pre-filled values if 
desired. 

4) Commands that support  sending either as a LP or HS command initially have 
their DTMode argument set to “Default”, which means the command will be sent 
using the current default DTMode setting (DT Mode control in the lower-left of 
the main window).  Alternatively, the user can specify the DTMode for certain 
commands by changing the DTMode argument to either LPDT or HSDT. 

5) Setting BTA to “Yes” requests that a bus-turn-around sequence follow the 
sending of the command.  This is usually used for read commands to allow the 
device under test to respond with data.  Note that the data response of the DUT is 
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not monitored by the PG, only the return BTA sequence, so the PG knows when it 
can resume transmitting (See section 3.10.4.8 for more details). 

6) Numeric fields are assumed to be decimal unless appended with ‘h’ 
(hexadecimal) or ‘b’ (binary).  For example “67h” = 103 and “1101b” = 13. 

7) Certain derived fields of the command will also be displayed in read-only text 
boxes (e.g. DataID, ECC, CheckSum).  These fields cannot be modified directly 
by the user but are computed according to the MIPI specification based on the 
command arguments.14  Note that video commands do not fill in these fields 
because they do not represent a single packet. 

8) Once the user is happy with the command definition, he may choose to save the 
command so that it can be assigned to a command button and saved as a named 
command in a configuration file.  To do this, the user should type a unique 
command name in the CmdName ComboBox and click on the Save button.   

9) After the command is saved, the label in the CmdName box changes to "untitled" 
to prevent confusion when the user then subsequently changes argument values. 
In this case, he is not changing the saved command definition but is beginning a 
new command definition. 

3.10.2 Assigning a Command to a Button 
Once a command has been defined, the user can right-click on a button to bring up a 
context menu.  This menu allows the user to select a command to assign to the button.  
Note that buttons maintain separate DSI and CSI command sets, selected when the 
protocol is changed using the Standard menu. 
 
After a command is assigned to a button, if the “Display command on button hover” 
option is checked (see section 3.7), the user can see the command definition merely by 
hovering the mouse over the button.  In this case, the command fields in the left pane of 
the main window will be filled in with the command definition.  If this option is not 
checked, the user must select the command for editing to view its arguments in the left 
pane of the main window (see next section). 

3.10.3 Editing an Existing Command 
An existing command definition can be edited as follows: 
 
1) Load the command field values into the edit controls either by right-clicking on a 
button having a command assignment and selecting "Edit" or selecting the command 
name from the CmdName drop-down control. 
2) Edit the command fields 
3) Click the Save button.  A confirmation message will ask whether it is OK to overwrite 
the existing command definition.  Click OK to do so. 

                                                 
14 To modify read-only fields, the user can use the “Send Cmd To File” menu option (File menu).  This 
outputs the command bytes to a text file that can subsequently be modified and resent using the File 
command.  
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3.10.4 Special Command Types 
 
3.10.4.1 Video Command Definition 
The four DSI video commands (i.e. Pixel Stream commands) and all of the CSI video 
commands all take a data file name and a frame count as arguments.  The data file name 
should reference a file with one of the following characteristics: 
 

• A file having the extension “.bmp”.  This file should be a 24-bit RGB BMP file 
having the exact width and height required HActive and VActive fields of the 
current timing configuration (see section 3.6.3).  In this case, the BMP image is 
read in and converted to the correct format for the associated video command.15   

 
• A file having any other extension.  This file should be a binary file having at least 

the number of bytes required by the current timing configuration.  That is, 
HActive * VActive * BytesPerPixel.  In this case, bytes are read in and treated as 
video data in the correct format for the associated video command.  

 
To play a sequence of multiple frames, the data file name should reference the first frame 
of the sequence and have the following format: “<name><index>.<ext>” where <name> 
is an arbitrary file name, <index> is an integer and <ext> is the file extension.  
PGRemote will derive the file names of subsequent frames automatically by 
incrementing <index>. 
 
For example: if “c:\frame1.bmp” is specified as the data file name and the frame count is 
set to four, PGRemote will look for the files “c:\frame1.bmp”, “c:\frame2.bmp”, 
“c:\frame3.bmp”, and “c:\frame4.bmp”. 
 
3.10.4.2 Variable Argument Commands 
Certain DSI commands allow the user to specify a variable number of parameters through 
an argument text box named “Params[]”, specifically the following commands: 
 

1. Generic Short Write Command 
2. Generic Read Request 
3. DCS Short Write, Custom DCS Command 
4. DCS Read Request, Custom DCS Command 
5. Custom Command 

 
The differences between these commands are minimal.  The Custom Command allows 
the user to specify an arbitrary DataID byte.  The other commands implicitly fill in the 
Data Type and allow the user to specify a Virtual Channel argument.  The DCS 
commands also allow the user to specify the DCS command byte.  All allow a variable 
number of arbitrary arguments, computing the packet length (for long packets), ECC, and 
Checksum (for long packets). 

                                                 
15  Note for CSI Raw<N> video commands, image data is converted to YUV format and the 
luminence channel data is used with the appropriate precision. 
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The actual packet constructed may have either long or short packet formatting, depending 
on the number of values parsed from the Params[] argument string.  For packet types (1), 
(2) or (5), if Params[] contains 0, 1, or 2 bytes, then short packets will be constructed.  
For packet types (3) or (4), if Params[] contains 0 or 1 byte, then short packets will be 
constructed (prepended with the DCSCmd byte).  Otherwise, long packets will be 
constructed and you will see additional read-only fields for the packet length and 
checksum appear.   
 
The Params[] argument string consists of byte values separated by white-space or 
commas.  As with other argument fields, values are assumed to be decimal unless 
appended with ‘h’ (hexadecimal) or ‘b’ (binary).  For example, “30 41h 10101b” is a 
legal parameter string. 
 
3.10.4.3 Long File Format Commands 
Two DSI packet types, the Generic Long Write and DCS Long Write formats, have a 
DataFileName argument.  For these commands, the file will generally be treated simply 
as a binary file.  However, the ASCII file format described in the section about the File 
Command can also now be used with these commands.  Please see this section for more 
information.   
 
Regardless of the file format used, for the Generic Long Write and the Write LUT 
commands, the entire file is sent in the long packet.   The WriteMemory commands have 
special support in PGRemote because these commands are often used to send video data 
to a frame buffer on the DUT.  The next section describes this support. 
 
3.10.4.4 DCS WriteMemory Commands 
For the Write Memory Start and Write Memory Continue commands, the WriteLen 
argument specifies the number of bytes to send and the FileOffset argument specifies the 
starting byte offset in the file or frame buffer. 
 
IMPORTANT: the parameter name FileOffset is misleading when using BMP files and 
the video format is not RGB888.  The parameter would better be called FrameOffset.  
The reason is that this parameter is used after the file has been imported and converted to 
the output video format. 
 
For example, for a 100 x 100 image in RGB666 (18-bits per pixel), an offset of 1800 
references pixel 800 (= 1800 / (18/8)), which is the first pixel of line 8.  In RGB888, an 
offset of 1800 references pixel 600, the first pixel of line 6.  The line length in RGB666 is 
100 * (18/8) = 225 and, in RGB888, is 100 * 3 = 300  
 
PGRemote has additional features that enhance the behavior of sending WriteMemory 
commands: 
 
 BMP File Decoding – If a file has extension “.bmp”, the image data is first 

imported before it is sent in the long packet.  In this case, FileOffset refers to the 
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byte offset in the decoded image data and not the file.  In addition, the decode 
format (e.g. RGB 8-8-8, 5-6-5, etc) can be selected via the ConfigWriteMemory 
dialog. 

 Block Partitioning – A single WriteMemory command can be partitioned into a 
sequence of WriteMemory commands.  The user configures this behavior via 
“Configure WriteMemory Commands…” in the Options menu.   

 
Figure 9 shows the ConfigWriteMemory dialog which has the following controls: 
 

 
Figure 9 – Config WriteMemory Dialog 

 
Enable Partitioning CheckBox – when checked, partitioning is enabled and 
WriteMemory commands will be deconstructed into a sequence of WriteMemory 
commands according to the parameters in the dialog.  Otherwise, WriteLen values greater 
than 64 KB will return an error.   
 
Partition Length – indicates the maximum length to use for component WriteMemory 
commands in the sequence.  
 
LP11 Partition Interval – indicates the amount of time to spend in LP11 between each 
component WriteMemory in the sequence.  Specify zero for no delay between component 
commands, which also means the command sequence will occur in a single HSDT or 
LPDT burst. 
 
BMP Decode Format – specifies the format to decode files that have an extension of 
“.bmp”.  These formats include: 

• Packed 16-bit RGB 5-6-5 
• Packed 18-bit RGB 6-6-6 
• Loosely packed 18-bit RGB 6-6-6 
• Packed 24-bitRGB 8-8-8 
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As an example, consider a WriteMemoryStart command issued with the following 
configuration settings: 

Partition Length = 30000 
LP11 Partition Interval = 1.5 us 
BMP Decode Format = Packed 24-bit RGB 8-8-8 

 
If the file specified has extension “.bmp”, FileOffset = 0, and WriteLen is 100000, 
PGRemote will send the following sequence: 
 

WriteMemoryStart with RGB888 image data bytes 0-29999 
LP11 for 1.5 us 
WriteMemoryContinue with RGB888 image data bytes 30000-59999 
LP11 for 1.5 us 
WriteMemoryContinue with RGB888 image data bytes 60000-89999 
LP11 for 1.5 us 
WriteMemoryContinue with RGB888 image data bytes 90000-99999 
LP11 for 1.5 us 

 
3.10.4.5 File Command 
The File Command is another way to define a custom command.  In this case, the 
command references a file having one of two formats, an ASCII format or a binary 
format.  The file defines the data packet data entirely, i.e. PGRemote does not compute or 
insert any bytes such as ECC, payload length or checksum. It is presumed the file data 
already has the correct packet format.  Note that the file data could also consist of 
multiple DSI packets.  When the file command is sent to the PG, PGRemote will send file 
data as a single HS or LP packet depending on DTMode.   
 
The ASCII file format has the following syntax: 

• A comment line begins with “//” and is ignored by the parser. 
• A blank line that consists solely of spaces or tabs is ignored by the parser. 
• The first non-comment, non-blank line should be “#ASCII”. 
• Subsequent lines define hex data bytes separated by white-space or commas. 
• Any number of hex data bytes are allowed per line. 

 
Example: 

// This is an example ASCII file for the File Command 
#ASCII 
18 04 00 4f 
87 4d 22 8c 

 
If the parser cannot find the #ASCII token in the specified file, it is assumed to be a 
binary file.  In this case, all bytes in the file are considered to comprise a data packet or 
series of packets to associate with the command name. 
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3.10.4.6 Conformance Testing (via File Command) 
Additional in-line commands have been introduced into the ASCII file syntax for the File 
command to support low-level protocol conformance testing.  These in-line commands, 
when present, modify default DPhy protocol behavior to introduce (generally) errors into 
the output stream. 
 
In-line commands have the following syntax: 
 Format: #<cmd> <arg1> <arg2> … 
 Numeric arguments are always hexadecimal 
 One command per line 
 Commands must precede #ASCII command 
  
The following in-line commands are supported: 
 

#HS_SOT <lane0_SOT> <lane1_SOT> <lane2_SOT> <lane3_SOT> 
Defines the SOT bit pattern for each lane  
Only applies when File command is sent in HSDT mode 

 Bits are sent from SOT lsb first (i.e. default SOT is B8) 
 <lane_SOT> can range from 0-FF (all 8 bits are used), in hex format 
 
#HS_END_BITS <value> <bitCnt> 
 Defines <bitCnt> bits from <value> to be added (as partial byte)  

to end of HS packet 
 Only applies when File command is sent in HSDT mode 

 Bits are taken from <value> lsb first 
 <value> can range from 0-FF, in hex format 
 <bitCnt> can range from 1-7 
 
#LP_LPDT <value>  
 Defines the LPDT command pattern  
 Only applies when File command is sent in LPDT mode 
 Bits are send from LPDT lsb first (i.e. default is 87) 
 <value> can range from 0-FF (all 8 bits are used), in hex format 
 
#LP_RAW 
 File bytes define the entire LP sequence output  
 Ignores DTMode (data is always sent as LP)  

Each byte pattern is output every TLPX time period 
For each byte: 

  Lane 0 is defined by D[1..0] 
  Lane 1 is defined by D[3..2] 
  Lane 2 is defined by D[5..4] 
  Lane 3 is defined by D[7..6] 
 The two bits associated with a lane represent its LP state: 

00 = LP00, 01 => LP01, 10 => LP10, 11 => LP11 
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#LP_RAW_WITH_CLOCK 
 File bytes define entire LP sequence output including clock LP signals. 
 Ignores DTMode (data is always sent as LP) 
 Each pair of bytes in pattern is output every TLPX time period 
 Within each pair of bytes: 
  Clk is defined byte D[1..0] of byte 1 

Lane 0 is defined by D[1..0] of byte 2 
  Lane 1 is defined by D[3..2] of byte 2 
  Lane 2 is defined by D[5..4] of byte 2 
  Lane 3 is defined by D[7..6] of byte 2 
 The two bits associated with a lane represent its LP state: 

00 = LP00, 01 => LP01, 10 => LP10, 11 => LP11   
 
Examples: 
 #HS_SOT B7 B8 B8 B8 
  Causes a 11101101 bit sequence to be output as HS_SYNC for lane 0 
  and the correct 00011101 HS_SYNC to be output on lanes 1-3 
 

 #HS_END_BITS 18 5 
  Adds a 00011 5-bit sequence to the end of HS burst.data 
 
 #LP_LPDT B7 
  Sets the LPDT code to B7 
 
 #LP_RAW 
 #ASCII 
 FF EE DD CC DD EE FF 

Sends the pattern: LP11, LP10, LP01, LP00, LP01, LP10, LP11 out on 
lanes 0 and 2 while outputting LP11 on lanes 1 and 3. 
 

#LP_RAW_WITH_CLOCK 
 #ASCII 
 03 FF 03 EE 03 DD 03 CC 03 DD 03 EE 03 FF 

Sends the pattern: LP11, LP10, LP01, LP00, LP01, LP10, LP11 out on 
lanes 0 and 2 while outputting LP11 on data lanes 1 and 3 and the clock 
lane. 

 
 
Note also that the “Send Cmd To File” option allows any single command (non-macro, 
non DCS WriteMemory, non-video command) to be sent to a file rather than to hardware.  
The format of this file is ASCII text, suitable for editing and re-sending to hardware via 
the File command.  For protocol testing, specifically, the user can edit any packet header 
fields, e.g. ECC, as well as the packet CRC bytes.  
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3.10.4.7 LPDelay and LPDelay (All Lanes) 
The LPDelay and “LPDelay (All Lanes)” commands are low-level DPhy constructs that 
allows the user to assert a particular LP pattern on the bus for a specified period of time 
(or otherwise place the LP and HS transmitters in a high-impedance state for a specified 
period of time).  As all commands are bracketed by LP11, this command is mostly useful 
in a macro sequence. 
 
The LPDelay comand  affects only the LP signal state of lane 0.  Other lanes are held in 
LP11.  Its arguments are as follows: 
 

• Delay (us) – the length of time to hold the LP bus in the specified state.  This 
value is floating point. 

• LP Driver En (0/1) – set to 0 to set the drivers in high-impedance, 1 to enable 
the LP drivers. 

• LPValue[1:0] – lane 0: set to 0 (LP00), 1 (LP01), 2 (LP10), or 3 (LP11)16 
 
The “LPDelay (All Lanes)” command was recently added to allow the user to control the 
LP signal state on all four data lanes plus the clock lane:   
 

• Delay (us) – the length of time to hold the LP bus in the specified state.  This 
value is floating point. 

• LP Driver En (0/1) – set to 0 to set the drivers in high-impedance, 1 to enable 
the LP drivers. 

• LPValue[1:0] – lane 0: set to 0 (LP00), 1 (LP01), 2 (LP10), or 3 (LP11) 
• LPValue[3:2] – lane 1: set to 0 (LP00), 1 (LP01), 2 (LP10), or 3 (LP11) 
• LPValue[5:4] – lane 2: set to 0 (LP00), 1 (LP01), 2 (LP10), or 3 (LP11) 
• LPValue[7:6] – lane 3: set to 0 (LP00), 1 (LP01), 2 (LP10), or 3 (LP11) 
• LPValue[9:8] -- clk lane: set to 0 (LP00), 1 (LP01), 2 (LP10), or 3 (LP11) 

 
3.10.4.8 Cmd Insertion Point 
A new packet type has been introduced – “Cmd Insertion Point” – to allow command 
insertion during a looping macro.  This feature is similar to command insertion during 
video mode.  Its single parameter is a Delay value in microseconds, which represents a 
reserved period of time the bus will normally be in LP11.  However, if  a command is 
inserted, the command will be output during this time (and any remaining time after the 
command will still be spent in LP11). 
 
The following describes command insertion behavior: 
 

• To insert a command, the option “Enable Command Insertion” must be checked. 
 

• A command sent while the macro is looping will attempt to be inserted. 
 

                                                 
16  Note that until PGRemote version 1.0.46, the LPValue argument of the LPDelay command 
incorrectly output LP10 for (LPValue == 1) and LP01 for (LPValue == 2). 



The Moving Pixel Company PGRemote User’s Manual – Doc. Rev. 2.0 -- 6/10/13 

- Page 47 - 

• To send a subsequent command but not insert it, either stop the PG using the “PG 
Abort” button or uncheck the “Enable Command Insertion” option. 

 
• If the inserted command requires more PG vectors than that reserved by the Cmd 

Insertion Point (via its Delay parameter), an error message will be reported. 
 

• When a command is inserted, PGRemote requests that the probe check to see if it 
can detect the insertion command code in the output stream.  If it is not detected 
within ½ second, an error will be reported.  To disable this check, select the 
“Disable command timeout” option.  This option should be checked if the “Run 
PG on external event” option is enabled or the macro contains a “Wait Ext Event” 
command. 

 
• If a command is inserted when the PG is waiting on an external event to continue 

output, the command is queued to be sent when output resumes and the insertion 
point is reached.   

 
• If a macro contains multiple command insertion points, an inserted command will 

be output at the next encountered insertion point.  Unless sequencing is controlled 
via external events, the user has no practical control over which command 
insertion point is used for the inserted command. 

 
3.10.4.9 Read Commands and BTA 
Read commands by default have their BTA (bus turn-around) argument set to “Yes”.  
This argument can be set to “Yes” by the user for other commands as well.  When BTA 
is set, the DPhy BTA signaling sequence is appended to the command, causing the slave 
device to obtain ownership of the bus subsequently.  After the slave is done with the bus, 
it sends its own BTA sequence to return the bus back to the master. 
 
When a command or macro having a BTA is sent, the P331 probe behaves exactly as 
desired.  The probe pauses PG output, places its drivers in high-impedance until it 
receives a BTA response sequence, drives the BTA acknowledgement sequence, then 
resumes PG output driving data back onto the bus.  In the event that no BTA response is 
received, the PG times out and drives LP11 back onto the bus. 
 
3.10.4.10 BTA and BTA_WAIT 
A BTA sequence can also be sent on its own, without accompanying data by selecting 
“Bus Turn Around” in the PktType field of the command.  Alternatively, selecting “Wait 
For BTA” causes the P331 probe to put its outputs in high-impedance and wait for a BTA 
return sequence from the device under test.  
 
Notes:  

• These commands are most useful when embedded in a macro with other MIPI 
commands.  Component commands in the macro following a BTA or 
BTA_WAIT are not output until the return BTA is recognized.    
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• In general, all non-video, non-looping commands will time out within about a 
second if a macro or command does not complete.  To avoid timeout, the user can 
set the “Disable Command Timeout” option (Options menu).  In this case, the 
user can press the PGAbort button to abort the command or macro if desired. 

• While the PG and P331 are waiting for the return BTA response, the main 
window status bar will display “Waiting on BTA…”.  

• The RPC command equivalents to these two commands are RPCDefs.BTA and 
RPCDefs.WAIT_FOR_BTA.  

 
3.10.4.11 Clock On and Clock Off 
The “Clock On” and “Clock Off” commands are generally meant to be used within a 
macro (though they are not disallowed to be sent as individual commands).  They give 
the user control over the clock lane, turning it on and off during component commands of 
the macro.  Please section 3.7 for a more comprehensive discussion on clock lane 
behavior. 
 
3.10.4.12 Escape Command 
The Escape Command option lets the user send a DPhy escape command byte.  The only 
argument is the command byte to send.  Note that this command is different than a packet 
sent in LPDT mode.  LPDT mode prepends the LP transmission with 0x87 to put the 
receiver in LPDT mode, and then sends the packet bytes. 

3.10.5 Sending a Command to the PG 
Once PGAppDotNet and command configuration has been set, commands may be sent to 
the PG (via the PGAppDotNet server).  To send a command assigned to a button, merely 
left-click on the button.  You can also select the command in the CmdName ComboBox 
and click on the Send button.  Finally, a command definition does not have to be saved to 
be used.  Just fill in the ComboBox and TextBox values as before but instead of saving, 
just click the Send button.     
 
After the user requests a command to be sent, messages in the status bar will update 
progress.  During this time, PGRemote performs the following tasks: 
 

• The command is parsed and any necessary external file data imported (and 
decoded in the case of BMP files) 

• MIPI protocol packets are built along with signaling structures (i.e. SOT, EOT, 
BTA, etc). 

• Packet data is converted to PG vectors, and a PG program blocks and sequence is 
built and sent to the PGAppDotNet server. 

• The PG is “Run” which downloads the PG program information to the PG3A 
module and initiates output. 

• If the command is a looping video command, control is returned to the user at this 
point.  Sending of the command is complete, though the PG continues to run. 

• Otherwise, PGRemote waits for the PG to finish before returning control to the 
user.  If the “Turn clock on/off each command” option is unchecked (available for 
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the P331) the clock state remains in HS mode after the command is complete.  
Otherwise, the clock lane returns to LP11 state. 

 
3.10.5.1 PG Abort 
As described above, the sending of commands goes through several stages of 
processing, some of which may take significant time.  Program download, in 
particular, can take tens of seconds to complete for video commands, when large 
blocks of video data are sent to the PG3A.  During this time, the user may click the 
PGAbort button (located in the bottom-right pane of the main window) to abort 
command sending.  In addition, once a video command is running and the PG is 
actively looping video data, the PG Abort button may be clicked to stop the PG.   
 
3.10.5.2 PG Restart 
The PG Restart button in the bottom-right pane of the main window is used to 
resend the previous command, bypassing the potentially lengthy download 
process, useful, in particular, for video commands.  When the PG is restarted, all 
timing configuration and parameters such as frequency, lane count, and clock 
start/stop mode from the original command are used (ignoring any changes since 
the command was sent).   

3.10.6 PG Status 
During operation, additional status is displayed in the lower-right pane of the PGRemote 
main window.  This status is updated every second and includes the following: 
 

• The PG run state (running, stopped) 
• The clock lane state (running, stopped, or ULP).   
• The data lane state (enabled, or ULP). 
• Whether any LP contention has been detected since the last status reset  
• Read response data received from the DUT after a BTA.17 

 
Note that only the P331 can support the ULP lane state and contention detection and 
optionally maintain a continuous clock when the PG is stopped.  In addition, only the 
P331 can acquire any read response data from the DUT. 
 
3.10.6.1 Contention Detection 
The P331 is equipped with contention and data receivers, whose thresholds can be set by 
the user in the PG Configuration dialog (see section 3.4.1 for more details).  When the 
probe is outputting an LP high voltage and its receiver detects a voltage below the LP 
High contention threshold, an LP high fault is detected.  When the probe is outputting an 
LP low voltage and its contention receiver detects a voltage above the LP Low contention 
threshold, an LP low fault is detected. 
 

                                                 
17 Note: LPDT response acquisition requires P331 firmware version 1.6 or above and 
assumes DUT response data is sent via an LPDT command. 
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As these faults can occur on either LP signal wire this results in four possible contention 
faults displayed as status: “LP0H”, “LP1H” (high faults) and “LP0L”, “LP1L” (low 
faults).  Contention flags, once detected, are held until a subsequent command is sent or 
the Status Reset button is pressed to clear state.  Note also that the aggregate contention 
state is reflected on the Evt1 signal of the P331 back panel (see Figure 2), allowing for 
instrument trigger on the onset contention. 
 
3.10.6.2 DUT Response 
When a command or macro containing a BTA is sent, the P331 (with firmware version 
1.6 or above) monitors the link for an LPDT response command from the DUT.  The  
DUT response (if any) is displayed in the status pane of the main window as the string 
“DUT Resp: “ followed by hex data bytes (up to 12).  Note that the first byte is special, 
containing only the first two bits captured from the DUT, and should always be 01h.  
These bits represent the escape entry bit pattern (LP10, LP00, LP01, LP00).  Subsequent 
bytes represent bits obtained after escape entry, starting with the escape command, which 
is expected to be 87h for an LPDT command.  Thus, the first header byte of the DUT 
response command will be in the third byte of the displayed DUT response data. 
 
The DUT response buffer is reset every time a PGRemote command is sent, but this 
could consist of a macro with multiple read commands.  In the P331 and P332, the 
response buffer is very small (12 bytes) and thus is not suited for capturing multiple 
responses from the DUT during a macro.  On the other hand,  in the P338, the response 
buffer is relatively large (4 Kbytes) and thus can capture a significant amount of data 
from multiple reads.   
 
In the P338, to facilitate parsing of data from the DUT response buffer, an additional flag 
is added (0x100) to the data bytes to indicate a new BTA.  Thus, the first response byte 
from each command should now start with 0x101 (rather than 0x01 for the P331/P332). 
 
Note, there are two RPC commands that can be used to obtain the DUT response: 
 

• GET_DUT_RESPONSE can be used programmatically to obtain the last response 
from the DUT. 

 
• SAVE_DUT_RESPONSE can be used either in a script file or programmatically 

to save or append the last response from the DUT to a text file. 
 
Please see Appendix B for command syntax. 

3.10.7 Saving/Restoring Command Configurations 
A default.cfg file is provided with PGRemote installation that has several single 
parameter commands defined (they all assume the Virtual Channel of the slave device is 
0).  Once you add new command definitions, you can save your command configuration, 
command set, and button assignments in a configuration file.  Use the "File->Save 
XXX.cfg As..." menu option and specify the name of the file to save to. Similarly, you 
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can load a configuration file with the "File->Load..." menu option.  Also, the last 
configuration file saved before exit is restored on relaunch. 

3.11  Macros 
A macro is a sequence of non-video commands, grouped and named as a single, new 
command.  Once defined, they can be assigned to command buttons and sent to the PG 
like any other command.  When viewing and creating macros, an additional pane in the 
main window is shown that displays the component commands of the macro and allows 
basic macro editing (see Figure 10 below). 

3.11.1 Defining a new macro 
To define a new macro, click on the “Start Macro” button at the bottom right of the main 
window.  This button will change its caption to “End Macro” and will cause the macro 
pane to appear with no component commands in the macro commands list-box (unless 
the current command is a macro command, in which case the component commands of 
the macro will be shown – see the next section).  In this mode (called macro mode), 
commands that are sent either via a command button, via the Send button at the top of the 
main window, or via an RPC programmatic command are entered into the macro instead 
of sent to the PG.  Figure 10 shows an example of a macro in edit mode. 
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Figure 10 – Macro Editing 

   
Commands are inserted into the macro at the location highlighted in the macro pane.  
When inserted, the “DSI Cmd” field name is used to label the compenent command of 
the macro.  The user can scroll and select a command (or the blank line at the end of the 
command list) to mark the next command insertion location.  Selecting a command also 
displays its arguments for viewing and modification. 
 
Four buttons are available in the macro pane to manipulate the component commands of 
a macro.  Clear All removes all the commands from the macro.  Delete removes the 
selected command from the macro.  Up moves the selected command up within the 
command sequence and Down moves the selected command down within the command 
sequence. 
 
When macro definition is complete, the user clicks on the “End Macro” button, bringing 
up a small dialog to name the macro, save it, and exit macro mode (the user may also 
Cancel to return to macro editing or Discard to discard the macro edits entirely. 
 
As with command definition, if the user specifies the same name when saving a macro, 
the user will be asked for permission to replace the existing macro definition.   
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3.11.2 Editing an Existing Macro 
To edit and existing macro, the user has two options.  If the macro is assigned to a 
command button, the user may right-click on it and select “Edit Current Command…”.  
Alternatively, the user can select it in the command combo-box at the top of the main 
window then click on the “Start Macro” button.  The macro can then be edited as normal 
and saved by clicking on the “End Macro” button.  The name field will be filled in with 
the original macro name and the user can click OK and confirm overwriting the existing 
macro. 

3.11.3 Copying a Macro 
To copy a macro, simply load a macro for editing, click on the “End Macro” button, and 
replace the original name with a new name. 

3.11.4 Editing a Component Command 
To edit a component command of a macro, perform the following: 
 

1) Open a macro for editing. 
2) Click on a component command in the macro to retrieve its argument settings. 
3) Change the argument settings as desired. 
4) Click the ‘Send’ button to insert the modified command into the macro (both the 

new command and old command will now be in the macro list) 
5) Click the ‘Delete’ button to delete the old component command. 
6) Click the ‘End Macro’ button and Click ‘OK’ to save the modified macro. 

3.11.5 Allowed Component Commands 
Any single LP or HS command can be inserted into a macro.  In addition, here are notes 
on inserting special command types in to a macro: 
 
 Component commands with BTA enabled are allowed in macros and behave as 

expected.  The PG twaits for a return BTA before continuing with the remaining 
component commands in the macro. 

 WriteMemoryStart and WriteMemoryContinue commands are fully supported in 
macros, including BMP file decoding and command partitioning to support large 
WriteLen counts.  

 Macros cannot contain other macros; that is, macro nesting is not allowed.  
However, macros can nonetheless be added to other macros, in which case the 
component commands of the macro being added are themselves duplicated and 
added to the macro being edited. 

 Unlike all other commands, video mode commands are treated differently when 
added to a macro than when sent directly.  In a macro, video mode commands 
simply add a single video data packet to the macro (unlike the entire video frame 
that is built when sent directly).  Other differences from video mode usage: 

 
1) The entire contents of the given file are put in the video packet 
2) The FrameCnt parameter is ignored 
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3) The file argument is assumed to be in binary format (i.e. BMP file decoding is 
not supported).   

 
Thus, to manually build an entire video frame into a macro would require a binary 
file for each active line.  This capability is more suited for programmatic macro 
building using RPC commands. 

3.11.6 HS Component Command Behavior  
When macros are parsed by PGRemote, the application groups HS component commands 
(that don’t have BTA enabled) into a single HS burst.  To send HS component commands 
in its own burst, the user must put an LPDelay call between each HS command. 

3.11.7 DPhy Clock Lane Behavior 
In macros, clock lane behavior can be modified from its default behavior using the Clock 
On and Clock Off commands.  These commands can be inserted at any position in a 
macro to turn the clock land on and off (according to the procedure defined in the DPhy 
standard).  Please see section 3.7.1 for more details. 

3.11.8 Additional Notes on Macro Behavior 
Below lists some final miscellaneous notes on PGRemote behavior when working with 
macros: 
 

• Macro names must be distinct from command names.  PGRemote will not allow a 
macro to be saved with the same name as a command and vice versa. 

• Note that once commands are added to a macro, they are duplicated and no longer 
are associated with the original command.  Specifically, if the original command 
is then modified and saved, the duplicate command in the macro having the same 
name does NOT change.  Moreover, although it would be a confusing practice to 
do this, multiple component commands may be added to a macro that have the 
same name but different arguments.  

• Also, sending an RPC script that contains SEND_MIPI_CMD calls while 
PGRemote is in macro mode adds the commands to the macro.  Note that other 
RPC command types in the script are executed (if possible in macro mode) at the 
time the script is sent.  These command types are NOT saved in the macro.    

 



The Moving Pixel Company PGRemote User’s Manual – Doc. Rev. 2.0 -- 6/10/13 

- Page 55 - 

4 PGRemote RPC (Remote Procedure Calls) 
To facilitate automated testing, PGRemote supports incoming RPC requests from other 
applications via a Microsoft .NET TCP server port.   To support this function, a separate 
DLL called PGRemoteRPC.DLL is provided, written in .NET.  Any programming 
language that can interface to a .NET DLL can use this capability. 
 
Alternatively, RPC commands have a script form that can be used in a text script file and 
run from the PGRemote GUI.  In this case, no external programming is required.  Many 
customers use script files extensively as they are a very powerful and convenient tool to 
configure and control PGRemote. 
 
A separate document titled PGRemoteRPC.pdf has been written to detail the RPC 
communication interface, supported commands, and example client code provided with 
installation of the PGRemote application.  Please refer to this document for more 
information. 
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5 P338 Probe 
The P338 probe is the newest MIPI probe made by the Moving Pixel Company.  In its 
“D5” form, it is a drop-in replacement for the P331/P332 probe (the P331 and P332 
probes have been discontinued).  Otherwise, its full-featured form has 8 data lanes and 
two clock lane outputs, grouped as two 4-lane DPhy links.  When both links are active in 
dual-interface modes, the P338 can be viewed as two synchronized P332 probes 
operating at up to 1.6 Gbps per lane.   
 
The main purpose of the P338 probe is to provide synchronized video output on its two 
DPhy links.  Frame timing is identical between the two links, but with each link having 
different source frame data.  Options include acquiring source frame data from separate 
BMP files, or the left/right half or the even/odd pixels from a single BMP file. 
 
On the other hand, both links do not always need to be active, and in single-interface 
modes, the P338 behaves almost identically to one P332 probe.  A couple significant 
improvements in the P338 versus the P332 are that the firmware is updatable in the field 
and up to 4 KB of DUT response data can be acquired. 
 
Depending on the operating configuration of the probe via PGRemote, one module or two 
linked PG modules can be used for MIPI data storage and program output.  When two PG 
modules are used this mode requires two PG modules connected with a Hydra cable and 
configured as a merged PG.  This configuration essentially comprises a fully 
synchronous, double-width PG having 128 channels.   
 
Generally, there is a one-to-one correspondence to the number of PG modules and the 
number of DPhy links that are active.  However, there is one half-rate mode that allows 
both interfaces to be driven from a single PG up to 800 Mbps.  Also, one PG can drive 
either interface at full rate (up to 1.6 Mbps) while the other is quiescent with all lanes in 
the LP11 state. 
 
The P338 probe uses an enhanced version of PGRemote called PGRemoteForP338.  This 
application only works with the P338 and PGRemote only works with the P331/P332.  
Substantially, all of the descriptions in this document about PGRemote apply to 
PGRemoteForP338, but, in addition, PGRemoteForP338 has numerous improvements.  
 
Both the P338 and PGremoteForP338 are described in much greater detail in a separate 
document entitled PGRemoteForP338UsersGuideSupplement.pdf.  Please refer to this 
document for more information. 
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6 Frequently Asked Questions 
This section provides answers to some of frequently asked questions. 

6.1 How do I implement a custom command? 
To send any custom DSI or CSI command where the dataID is not defined in the 
standard,  use the Custom Command packet type.  Provide the custom DataID in the field 
provided and type in arbitrary argument bytes as a list of values separated by spaces in 
the Params[] field.  You can append ‘h’ to make values hexadecimal.   If the list contains 
two or less values, the command will be sent in the short packet format. Otherwise, it will 
be sent in the long packet format with the length field appropriately set. 
 
If using RPC , use the CUSTOM_COMMAND RPC command, providing the custom 
DataID in the arg1 field.  If using an RPC script, provide argument bytes as a list at the 
end of the command.  If using RPC calls via the DLL, provide argument bytes in the 
"data" field of the MIPICmd DLL call. 

6.2 How do I implement a custom DCS command?  
To send a custom DCS short write command, you can select the ‘DCS Short Write’ as the 
PktType and ‘Custom DCS Command’ as the DCSCmdDesc.  Then enter the custom 
DCS command in the DCSCmd field and zero, one, or two arbitrary bytes as parameters 
in the Params[] field searated by spaces.   
 
To send either a DCS Read Request or a DCS Long Write, use the procedure for a 
generic custom command (above) putting the DCS command byte as the first byte in the 
argument list.   

6.3 How do I send a command to a file, modify it with an in-line 
command, and send it? 

 
1) Set up the desired packet type and its arguments to be sent in the left-side of 

PGRemote 
2) Select the "Send Cmd To File" option in the File menu.and specify a file name to 

write the packet data to. 
3) Open this file in a text editor and add the in-line commands you want before the 

#ASCII line 
a. e.g. add #HS_SOT A8 A8 A8 A8 or #LP_LPDT 86 

4) Save the file 
5) Back in PGRemote, select a PktType of "File Command" and browse for the text 

file name 
6) Set up any configuration settings such as DTMode and frequencies. 
7) Send the command. 
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6.4 How can I save my custom timing configurations? 
Timing configurations are not saved with user command definitions.  To permanently 
define new timing configurations, you should modify the text file in the application 
directory called Timing.Config.  To change or add timing configurations, simply edit this 
file using a text editor.  PGRemote does not provide the ability to save or modify 
configurations in this file using the GUI.  The syntax of the file is documented in section 
3.6.6. 
 
Another way to set your timing configuration is to use an RPC script file.  Often 
customers use this as method to initialize the entire state of PGRemote before sending a 
command or series of commands for testing. See next section. 

6.5 How can I use PGRemote to respond to read requests as a 
slave device? 

To do this, user’s can build a macro that begins with a special command called "Wait For 
BTA" and is followed by whatever sequence of packets the user wants to send in 
response to being given the bus via BTA (e.g. this is often a read response packet to the 
known read packet that is to be sent by the DUT).  The steps using the GUI would be: 
 

- Click the Start Macro button 
- Select "Wait For BTA" in the PktType drop-down 
- Name the command if you want by typing in the DSI Cmd Name field 
- Click the Send button to add it to the macro 
- Select "Generic Short or Long Read Response" in the PktType drop-down 
- Fill in the Params[] field and name the command by editing DSI Cmd Name if 

desired 
- Click the Send button to add it to the macro 
- Select "Bus Turn Around" in the PktType drop-down 
- Click the Send button to add it to the macro 
- Click the End Macro button, name it, and click OK. 

 
Now you can send the macro and PGRemote will display "Waiting for BTA".  However, 
after a couple seconds it will timeout.  Used this way, you will want to check the option 
"Disable command timeout" (Options menu).  Then, when the macro is sent, PGRemote 
will wait indefinitely until the DUT sends a BTA, at which point, the read response 
packet and subsequent return BTA will be sent (note that PGRemote will now be waiting 
for another return BTA as that is the semantics of the "Bus Turn Around" command).  At 
this point, you can click "PGAbort" to reset PGRemote and the PG. 

6.6 How can an RPC script file help with initialization? 
A good way to set up and control almost all aspects of PGRemote is using one or more 
RPC scripts.  In addition to their traditional use in sending a sequence of commands, you 
can use them to initialize all options, timing configuration, PG configuration, and DPhy 
configuration.  Define a script file for each unique test configuration you need. 
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For example, for PG configuration, you could use the following commands 
 
 # START_EDIT_CONFIG 

# SET_HS_LOW_VOLT 0 0.00  
# SET_HS_HIGH_VOLT 0 0.45 
# SET_HS_DELAY 0 00e-12  
# SET_HS_DELAY 1 00e-12  
# SET_HS_DELAY 2 00e-12  
# SET_HS_DELAY 3 00e-12  
# SET_HS_DELAY 4 500e-12  
# SET_HS_FREQ 400e+6  
# SET_LP_FREQ 20e+6  
# SET_LANE_CNT 4 
# END_EDIT_CONFIG 
 

For frame timing, you could use: 
 
# START_EDIT_CONFIG 
# SET_TIMING_HSYNC 62  
# SET_TIMING_HBPORCH 60  
# SET_TIMING_HFPORCH 16  
# SET_TIMING_HACTIVE 720  
# SET_TIMING_VSYNC 6  
# SET_TIMING_VBPORCH 31  
# SET_TIMING_VFPORCH 8  
# SET_TIMING_VACTIVE 480  
# SET_TIMING_LINE_TIME 31.7778  
# SET_TIMING_PIX_CLK 27.0000  
# SET_TIMING_FRAME_RATE 59.9400  

 
# SET_TIMING_ENABLE_CONTINUOUS_MODE 1  
# SET_TIMING_ENABLE_DSI_BURST_MODE 0  
# SET_TIMING_ENABLE_DSI_PULSE_MODE 1  
# END_EDIT_CONFIG 

 
And for DPhy timing configuration: 

 
# START_EDIT_CONFIG 
# SET_DPHY_PARAMETER DPHY_PARAM_HS_PREPARE 100  
# SET_DPHY_PARAMETER DPHY_PARAM_HS_ZERO 100  
# SET_DPHY_PARAMETER DPHY_PARAM_HS_EXIT 100  
# SET_DPHY_PARAMETER DPHY_PARAM_HS_TRAIL 90  
# SET_DPHY_PARAMETER DPHY_PARAM_CLK_PREPARE 70  
# SET_DPHY_PARAMETER DPHY_PARAM_CLK_ZERO 260  
# SET_DPHY_PARAMETER DPHY_PARAM_CLK_TRAIL 65  
# SET_DPHY_PARAMETER DPHY_PARAM_CLK_PRE 45  
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# SET_DPHY_PARAMETER DPHY_PARAM_CLK_POST 320  
# SET_DPHY_PARAMETER DPHY_PARAM_TA_GO 200  
# SET_DPHY_PARAMETER DPHY_PARAM_WAKEUP 2000000  
# END_EDIT_CONFIG  

 
Finally, for PGRemote options: 

 
# SET_OPTION OPT_CLOCK_ON_OFF_EACH_COMMAND 0  
# SET_OPTION OPT_ENABLE_CMD_INSERTION 0 
# SET_OPTION OPT_LOOP_NON_VIDEO_COMMANDS 1 
# SET_OPTION OPT_ENABLE_EOT_PKTS 1  
# SET_OPTION OPT_ENABLE_WM_PARTITIONING 1  
# SET_OPTION OPT_DISABLE_CMD_TIMEOUT 0 
# SET_OPTION OPT_RUN_PG_ON_EXTERNAL_EVENT 0 
# SET_WM_PARTITION_LENGTH 40000  
# SET_WM_PARTITION_INTERVAL 10   

 
Note that there now is a shorthand way to generate this initialization script file.  Simply 
do the following: 
 

1. Select Script->”Start Recording” 
2. Browse for the script file name to use 
3. Select Script->”Write Current State” 
4. Select Script->”Stop Recording” 

 

6.7 How do I adjust the clock and data delays while a command 
or video is looping? 

 
Here is the procedure: 
 

1) Send looping command or video.  
2) Bring up the PG Configuration dialog (click PG Cfg... button in main window)  
3) Check the "Real-time Adjust Mode" check box  
4) Click "No" in the message box that pops up asking whether it is "Okay to stop 
PG to update configuration".  
5) Adjust clock or data delays as desired.  
6) When done, click "Cancel" button in dialog  
7) Click "No" in the message box that pops up asking whether it is "Okay to stop 
PG to update configuration". 

6.8 How can I turn off the clock during LPDT commands? 
There is a way to turn off the clock during an LP command for a specific test.  That is to 
build a macro with the "Clock Off" command preceding the LP command.  An RPC 
script to do this is as follows: 
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# START_MACRO 
# SEND_MIPI_CMD CLOCK_OFF 0 0 DT_HS 0 0 0 0 "" NULL 
# SEND_MIPI_CMD DCS_SHORT_WRITE EXIT_SLEEP_MODE 0 DT_LP 0 0 0 0 "" 
NULL 
# SEND_MACRO 
 
Also, a related issue is to ensure the clock is off during LP blanking during video mode.  
This can be achieved by checking the checkbox "Turn clock off during LP blanking" in 
the New Video Mode configuration fields of the Timing configuration dialog.  

6.9 How can I send multiple video frames and step through 
them one by one using an external event (DSI video only)? 

To do this, set up to send multiple video frames as normal (i.e. set FrameCount greater 
than one and provide multiple BMP filenames with a proper incrementing number 
sequence).  In the timing configuration, both “New Video Mode” and continuous video 
must be selected.  Then, in the Options menu, check “Run PG on external event”. 
 
In this case, an external event line connected to the Event0 line of the P300 Inputs probe 
to the PG controls switching to the next video frame in the sequence.  Whenever the 
event line pulses high, video steps to the next frame.  After sending the video command, 
the event must occur to start playing the first frame of video.  This frame will loop until 
either PGAbort is pressed (which will end the video playback as usual) or the event 
signal occurs.  When the event signal occurs, the second frame will loop until either 
PGAbort is pressed or the event signal occurs again.  And so on.  Once the last frame has 
played, the first frame will play again. 

6.10 How can I efficiently send long LP-only commands? 
To answer this question, some details about how the PG is used to store and send MIPI 
commands.  Commands are built and stored in the PG before they are sent out using the 
P331/P332 probe.  The PG memory contains about 32 million vectors of memory.  This 
represents the limit of the size of any command, video sequence, or macro that can be 
sent at one time. 
 
PG vectors are effectively played out at the 2 * HS frequency, even for LP commands.  
This means that multiple vectors are used for each LP bit and thus can require significant 
memory depending on the ratio of HS frequency to LP frequency.  Because LP bits are 
one-spaced hot encoded (requiring 2 pulses per LP bit) the exact equation is: 
 
Vectors per LP bit = (4 * HSFreq / LPFreq). 
 
The most important piece of information to take away from this is that when sending 
large LP-only commands, you should set the LP frequency as high as possible or set the 
HS frequency as low as possible.  In the case of LP-only commands, PGRemote actually 
allows HSFreq to be set equal to the LPFreq (even though the minimum HS frequency in 
DPhy is 80 MHz).  This allows the most efficient memory usage in the PG and drastically 
increases the download time for large LP commands (e.g. WriteMemory).   
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6.11  What do I do when PGRemote displays “Unable to stop 
PG”? 

"Unable to stop PG" means that PGAppDotNet is not responding to requests from 
PGRemote to stop the PG .  This means that PGAppDotNet is in a confused state and 
should be shut down.  These kinds of strange errors should not happen very often, but 
when they do, it is best to shut everything down (close both PGRemote and 
PGAppDotNet) and start anew.  Make sure there are not other copies of the software 
running.  And, if all else fails, it may be best to reboot the computer.  
 
When starting up again, relaunch PGAppDotNet, connect to your PG (if it doesn't do so 
automatically), then bring up PGRemote.  You should not have any connection or 
initialization problems. 


